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 How wel w Microsof ? Many students can follow specific step-by-step 
directions to re-create a document, spreadsheet, presentation, or database, but do they truly 
understand t ls it takes to create these on their own? Just as simply following a recipe 
does not m e you a profession e-creating a project step by step does not make you 

pert. 

 The purpose of this book is to teach you t ls to master Microsoft PowerPoint 2010 in a 
straightforward and easy-to-follow manner. But  Microsoft® O owerPoint 2010: A Skills 
Approach, Complete  goes be how  and equips you with a deeper understanding of the 
 what  and the  why.  Too many times books have little value beyond the classroom. The  Skills 
Approach  series has been designed to be not only a complete textbook but also a reference 
tool for you to use as you move beyond academics and into the workplace. 

  ABOUT TRIAD INTERACTIVE 

  Triad Interactive is a small business and a District of Columbia Qual d High Technology 
Company specializing in online education and training products. 

 Triad’s gship program is Si et ® —a sim ted Microsof ning and assessment 
application developed for the McGraw-Hill Companies. SimNet development began in 
1999 with SimNet 2000, a CD-ROM-based program used to measure students’ understand-
ing of the Microsof pplications. I P, Triad expanded the 
Si et platform to include a learning component with lessons written by Cheri  Manning 
and Catherine Manning Swinson. Over the past 10 years, the SimNet series has continued to 
evolve from a simple CD-ROM program into a robust online learning and assessment sys-
tem. More than 500,000 students worldwide have used SimNet to learn t ls necessary 
to master Microsoft Office. 

 Triad is also actively involved in cancer education and in research projects to assess the use-
fulness of technology for helping high-risk populations m e decisions about managing 
their cancer risk and treatment.    
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O   and  What’s New in Microsoft O  . 

 Cheri began her career as an Aerospace Education Specialist with the Education Division of 
the National Aeronautics and Space Administration (NASA), where she produced materials 
for K–12 instructors and students. Prior to founding Triad Interactive, Cheri was a project 
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Multimedia MBA CD-ROM series.  
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 FIGURE WD 5.24 

Microsoft Office PowerPoint 2010: A Skills

 ❯ 1-1 Content in SimNet for Offi  ce 2010

 ❯ At-a-glance PowerPoint 2010 skills
 ❯ Introduction—Learning Outcomes are 

clearly listed.

 ❯ Diverse end-of-chapter projects
Projects that relate to a broad range of careers 

and perspectives, from nursing, education, 
business, and everyday personal uses.

Quick, easy-to-scan pages, for effi  cient learning

Approach, Complete

   3.1 Applying Themes 

 theme 

 FIGURE EX 3.1 

This worksheet has the default Office theme applied.

3.3 Changing the Theme Effects

theme effects

 1. 

 2. 

 3. 

FIGURE PP 3.3

Design Tab

Themes Gr

Theme E

chapter 4

 ❯ Delete, reorder, copy, and 

paste slides, and use the Office 

Clipboard

 ❯ Define a custom show and hide 

slides

 ❯ Add hyperlinks and comments

 ❯ Rehearse timings and use 

navigation tools

 ❯ Print presentations and handouts

Managing and 
Delivering Presentations

In this chapter, you will learn the following skills:

Skill 4. 1 

Skill 4.2 

Skill 4.3 

Skill 4.4 

Skill 4.5 

Skill 4.6 

Skill 4.7 

Skill 4.8 



 ❯ Instructor materials available on the online learning center, www.mhhe.com/offi  ce2010skills
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SimNet for Offi  ce 2010
Online training and assessment

IT’S EASY!

SimNet is an EASY & INTUITIV  

design. Instructors can quickl  

assign content around th  

edit throughout the semester  

sections and instructors!  SimN  

students can quickly scan t  

to identify the skills they k  

don’t . . . saving them time!

STUDENTS LEARN BEYOND THE BOOK!

SimNet off ers a complete co
learning side that present
several diff erent modes:

 ■ Teach Me: combines instru
graphics, and interactivity t

 ■

 ■

STUDENTS LEARN BEYOND THE 
COURSE!

  

 

Teach Me

INCLUDES:

■ Microsoft® Offi  ce Suite

■ Microsoft® Outlook

■ Windows XP

■ Windows Vista

■ Windows 7

■ Internet Explorer 7

■ Internet Explorer 8

■ Computer Concepts

  

w

e

www.mhhe.com/simnet2010

 





 Essential Skills for Microsoft 
Offi  ce and PowerPoint 2010 



    

      ❯ Learn about Microsoft Office 2010 

and its applications: Word, Excel, 

PowerPoint, and Access 

  ❯ Recognize Microsoft PowerPoint 

2010 common features and 

navigation elements 

  ❯ Create new PowerPoint 2010 

presentations 

  ❯ Demonstrate how to open, save, 

print, and close PowerPoint 

presentations 

  ❯ Use Microsoft Help 

  ❯ Perform basic editing tasks  

 Essential Skills for Microsoft 
Office and PowerPoint 2010 

skills

In this chapter, you will learn the following skills:  

  introduction 
  

 
   

 Skill 0.1 

 Skill 0.2 

 Skill 0.3 

 Skill 0.4 

 Skill 0.5 

 Skill 0.6 

 Skill 0.7 

 Skill 0.8 

 Skill 0.9 

 Skill 0.10 

 Skill 0.11 

 Skill 0.12 

 Skill 0.13 

 Skill 0.14 

 Skill 0.15 

 Skill 0.16 

 Skill 0.17 

 Skill 0.18  



   skill 0.1 Introduction to Microsoft Office 2010
   

  Microsoft® Office 2010 is a collection of business “productiv-
ity” applications (computer programs designed to make you 
more productive at work, school, and home). The most pop-
u pplications are:

Microsoft Word —a word processing program. Word 
processing software allows you to create text-based 

documents, similar to ho
on a typewriter. However,
more powerful formatting
to create complex docume
brochures, and newsletters.

   0.1 Introduction to Microsoft Office 2010 

FIGURE PP 0.1
A Word Documen

FIGURE PP 0.2
An Excel Spreadsheet

Microsoft Excel —a spreadsheet program. Origina , 
spreadsheet applications were viewed as electronic 
versions of an accountant’s ledger. Today’s spreadsheet 
applications can do much more than just calculate 

numbers—they include po  
analysis features. Spreadshe
everything from person
payments.
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  presentation program. 
able you to create robust, 

esentation consists of a 
ide contains content, 

including text, images, charts, and other objects. You can 
add multimedia elements to slides, including animations, 
audio, and video.

FIGURE PP 0.3

 ower nt resentat n

 se program. Database 
anize and manipulate large 
hat allow you to relate tables 

r are referred to as  relational  
r, you usu ly see only one 
rm.  Database forms use a 

ser to enter record data. 

For example, when you fill out an order form online, you 
are probably interacting with a database. The information 
you enter becomes a record in a database  table.  Your 
order is matched with information in an inventory table 
(keeping track of which items are in stock) through a 
query.  When your orde led, a database  report  can be 
generated for use as an invo  of lading.

FIGURE PP 0.4

An Access Database



   skill 0.1 Introduction to Microsoft Office 2010
   

       To open one of the applications:

    1. Click the Windows  Start button  (located in the lower-
left corner of your computer screen).  

   2. Click  l Programs.   

   3. Click the  Microsof e  folder.  

   4. Click the application you want to open.    

 Word, Excel, and Powe
Point open a new blank 

utomatica y; Access 
opens to Backstage view, 
where you are asked to give 

tabase a file n rst. 

  tips & tricks 
 

 

  

  tell me more 
 

   

     

 

  

  

 

  

  

 

  

     

  try this 
  

 

 

   1 .     

   2.  

    

 3.      

  from the perspective of . . . 
 COMPUTER SUPPORT SPECIALIST 

 

   

r-
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   THE RIBBON 

 ogram in the past, you may 
owerPoint 2010 for t rst 
oint 2007, Microsoft rede-

ng the fam iar menu bar/
nterface that makes it easier 

mands. 

 Ribbon he top of the application win-
tures and commands into tabs. 

Each  tab  organizes commands further into related  groups.

When a specific type of object is selected (such as a picture, 
table, or chart), a contextual tab will appear.  Contextual tabs

contain commands specific to the type of object selected and 
are only visible when the commands might be useful. 

 The  Home tab  contains the most commonly used com-
mands. In PowerPoint, the Home tab includes the following 
groups:  Clipboard, Slides, Font, Paragraph, Drawing,  
Editing.  

0.2 Exploring the PowerPoint 2010 User Interface 

     BACKSTAGE 

 File tab t side of t on. Click-
 Microsoft Office Backstage ™  

view, mands for managing and 

protecting your presentations including Save, Open, Close,
New, and Print. Backstage replaces the  O ton  menu 
from PowerPoint 2007 and the  File  menu from previous ver-
sions of PowerPoint. 

FIGURE PP 0.5

ab (Opens Backstage Vie

Contextual Tab
Tab

 

  

   

  

 

 

   

  tips & tricks 

  KEYBOARD SHORTCUTS 

 rough t on and Back-
gh keyboard shortcuts and 

Keyboard shortcuts nations of keys that you 
ome keyboard shortcuts refer 

eys that run across 
sing these ke ecute 

spe ands. For example, pressing the   1 ke l 
open Help in any Microsof pplication. Keyboard 
shortcuts typically use a combination of two keys, although 
some commands use a combination of three keys and others 
only one key. When a keyboard shortcut ca na-
tion of key presses, such as c + V to paste an item from 
the Clipboard, you mus rst press the mod r key (  c), 
holding it down while you press the   V key on the keyboard. 



   skill 0.2 Exploring the PowerPoint 2010 User Interface
   

SHORTCUT MENUS 

  Shortcut menus  are menus of commands that display when 
you right-click an area of the application window. The area 
or object you right-click determines which menu appears. 

For example, if you right-cl
shortcut menu of comm  
if you right-click an imag
commands for wor ng  i

FIGURE PP 0.6

ess d hold Ctrl and then press V

to paste text or item in a document.

 

 

      

   

   

   

   

         

    try this 

FIGURE PP 0.7

Right-Click Shortcut Menu
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     QUICK ACCESS TOOLBAR 

  cated at the top of the appli-
 b. The Quick Access Toolbar, 

ick one-click access to com-
mmands to and remove com-
oolbar. One of the advantages 
hat it stays visible no matter 

 To modify the Quick Access Toolbar:

    1. Cl Customize Quick Access Toolbar  button    
located on the right side of the Quick Access Toolbar.  

   2. Options with check marks next to them are already 
displayed on the toolbar. Options with no check marks 
are not currently displayed.  

   3. Click an option to add it to or remove it from the Quick 
Access Toolbar.    

FIGURE PP 0.8

Options with check marks 

next to them are already 

displayed on the Quick 

Access Toolbar.

Options with no check 

marks are not curren

displayed.

oolbar

  

   

    tips & tricks 



   skill 0.2 Exploring the PowerPoint 2010 User Interface
   

  THE MINI TOOLBAR 

 The  Mini toolbar  gives you access to common tools for 
working with text. When you select text and then rest your 

mouse over the text, the Min
click a button to change t

on. 

  

  
  try this 

FIGURE PP 0.9

 Mini r

     ENHANCED SCREENTIPS 

 A  ScreenTip  is a small information box that displa ame 
of the command when you rest your mouse over a button 
on t on Enhanced ScreenTip  displays not only 

the name of the comm
(if there is one) and a short
does and when it is used. Cer
include an image along with

FIGURE PP 0.10

Enhanced ScreenTip
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     USING LIVE PREVIEW 

 Live Preview icrosoft PowerPoint 2010 
 ch ges in your presentation 
he change. When Live Preview 
and on t o m-

he currently active text or 
, click the formatting option. 

 lowing:

    ❯  g the font, font size, and font 
  

   ❯ Paragraph Formatting —including numbering, bullets, 
and shading  

   ❯ Quick Styles and Themes   

   ❯ Table Formatting —including table styles and shading  

   ❯ Picture Formatt g —including correction and color 
options, picture styles, borde cts, positioning, 
brightness, and contrast  

   ❯ SmartArt —including layouts, styles, and colors  

   ❯ Shape les —including borders, shading cts    

FIGURE PP 0.11

The Live Preview feature allows you to see formatting changes, 



   skill 0.3 Customizing PowerPoint
   

  Whe rst installed, every version of PowerPoint has the 
same features enabled. However, you can enable and disable 
some of the user interface features through the  PowerPoint 
Options  dialog box. You can even change the colors used in 
the PowerPoint interface.

    1. Click the  e  tab to open Backstage view.  

   2. Click  Options.   

   3. Make the changes you want, and then click  OK  to save 
your changes.

    ❯ Check or uncheck  Show Mini toolbar on selection  
to control whether or not the Mini toolbar appears 
when you hover over selected text. (This does not 
affect the appearance of the Mini toolbar when you 
right-click.)  

   ❯ Check or uncheck  E  
Live Preview feature  

   ❯ Change the color sche
interface by expandin  
selecting  Silver, Blue,    

   ❯ Make a selection from t   

    ❯ Show featur   
Enhanced ScreenTi  

   ❯   Don’t show featur   
Enhanced ScreenTi
i eyboar   

   ❯   Don’t show ScreenTi  
so if you hold you

on, nothing wil

       0.3 Customizing PowerPoint 

FIGURE PP 0.12

   

    
    tell me more 
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  0.4 Designing Presentations 
  ls needed to create Power-

n to create slides, add text 
ransitions to slides. 

esentation, using Power-
esentation tools. 

 Before you learn the mechanics of creating and giving a pre-
sentation, there are some basic design principles tha l help 
you create more effective PowerPoint presentations:

 

   tips & tricks 
 

 

   

  tell me more 
  

     

 

   

  here are some basic dos 
ning presentations:



   skill 0.5 Opening an Existing Presentation
   

  0.5 Opening an Existing Presentation 
  Opening a presentation retrieves it from storage and displays 
it on your computer screen. 

 To open an existing presentation:

    1. Click the  File  tab to open Backstage view.  

   2. Click  Open.   

   3. The  Open  di og box appe
nd the folder locati  

is stored.  

   4. Select the presentation na   

   5. Click the  Open  button in     

FIGURE PP 0.13

    tips & tricks 
 

 

  

  tell me more 
 

    1.    

   2.    

   3.  

     

  try this 
         

 

  

    ❯  

  

   ❯   

   ❯        
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    0.6 Understanding Security Warnings in PowerPoint 
  ntation from a location that 

ly unsafe, it opens automati-
Protected View  provides a read-only 

uter from becoming infected 
otentially unsafe locations 

sages, or a network location. 

 Files that are opened in Protected View display a yellow 
warning bar at the top of the window, belo on. To 
disable Protected View, click the  Enable Editing  button in 
t w warning bar. 

FIGURE PP 0.14

 

   
    tips & tricks 

  tell me more  

 

 

    1.    

   2.  

  

   

   3.     

   4.   

  

   5.  

       



   skill 0.7 Creating a New Blank Presentation
   

  0.7 Creating a New Blank Presentation 
  When you open Microsoft PowerPoint from the  Start  menu, 
a new blank presentation appears on your screen ready for you 
to begin work. But what if you want to create another new 
presentation? Will you need ogram and then 
launch it again? The  New  comm lows you to create new 
presentations withou ing and reopening the program. 

 To create a new blank present

    1. Click the  File  tab to open  

   2. Click  New.   

   3. Under the  Home  section, t   
is selected by default. To c
click the  Create  button be
presentation.    

FIGURE PP 0.15

        

    
    try this 
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  0.8 Creating a New Presentation Using a Template 
 template h predefined settings that 

e a ne r own. Using 
matted and designed new 

t. There are tem-
ations or single slides. You can 

s presentations, medical and 
ighly sophisticated slides. 

 om a template:

    1.  stage view.  

   2.    

   3. eled  Available 
 ntation  option is considered 

 ives you access to all the 
puter. The   O com   

undreds of templates av  
ust have an activ ternet 
mpla om this section.  

   4. To nd a template from  , click the 
PowerPo t presentations and slides  category.  

   5. Cl ubcategories to view its templates.  

   6. Click each template image to see a preview of the 
template.  

   7. Whe nd the template you want to use, click the 
D d  button.  

   8. A new presentation opens, prepopulated with all of the 
template elements.    

 

  

      

    tell me more 

FIGURE PP 0.16



   skill 0.9    

  0.9 Modifying Presentation Properties 
Presentation Properties  provide information about a presen-
tation such as the location of the presentation, the number 
of slides in the presentation, when the presentation was cre-
ated and when it was last modified, itle, and the author. 
Properties also include ke ords, referred to as  tags,  that are 
u l for grouping common files toge er or for searching. 

l this information abou eferred to as  metadata.  

 To ew a presentation’s proper ick the  e  tab to open 
Backstag ew. Properties are listed at the fa gh Info  tab. 

 To add ke ords to a present
Tags  and type ke ords tha
rating each word with a comm  

 The Author property is adde
entered when you insta

ange the author na  
the Author property. 

    tips & tricks 
 

  

  tell me more 
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  0.10 Using Cut, Copy, and Paste 
      mands are used to move text 

esentation and from one pre-
ect that is  cut  is removed 

d on t lipboard 
Copy and places a duplicate of the 

lipboar t changing 
Paste mand is used to insert text or 

nto a presentation. 

 tion:

    1. d.  

     ipboard  group, click the 

Cut      

  or  

Copy         

   2. Place the cursor where you want to insert the text from 
the Clipboard.  

   3. he  Clipboard  group, click the  Paste     button.    

 These same steps apply whether you are cutting, copying, and 
pasting text, pictures, shapes, vide y type of object 
in a PowerPoint presentation. 

   y are placed on the  Office 

Clipboard. ard can store up to 24 items. 
 and, the item most recently 

ted into the current presenta-
 multiple items and then paste 

esentation, open t

Clipboard by cl ng the  dialog launcher     in the  Clip-
board  group. Next to each item in the Clipboard is an icon 
that ident he application from which the item originated 
(Word, Excel, PowerPoint, etc.). Fr Clipboard  task 
pane, click any item to paste it into the current presentation. 

  tips & tricks 
 

  

  tell me more 
  

 

  

  try this 
      

    ❯       

  

   ❯     

  

   ❯     
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   skill 0.11 Using Paste Special
   

    tips & tricks 
  

  

  tell me more 
 

 

     

      0.11 Using Paste Special 
  Using the  Paste Special  command, an object from another 

pplicat ple, an Excel spreadsheet) can be 
inserted into a PowerPoint slide. When pasting source mate-
rial from another program, you have two choices:

    Linked objects —Linked data are stored in rc  
formation in a linked object is update rc  

is edited. The destinati tores on cation of the 
sourc isplays a representat i ed data. 
Double-click the linked object to open the sourc   

   Embedded objects —Once pasted into your PowerPoint 
presentation, the data are independent of the original 
source. Information in an embedded object does not 
change if you modify the sourc ouble-click 
the embedded object to edit it within the PowerPoint 

presentation (using t  
source file).    

 To use the  Paste Special  comm

    1. Copy the object you wan  

   2. On the  Home  tab, in the     
button arrow and select  P    

   3. Select a format for pastin    
Different formats are ava
of the pasted material.  

   4. ant to paste the m
  radio button.  

   5. Click  OK.     

FIGURE PP 0.19
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  0.12 Using Undo and Redo 
  orking, the  Undo  command 

ion you performed. The  Redo

rse the  Undo  command and 
tate. The Quick Access Tool-

oth commands. 

 ick the  Undo  button    on 
 

 ick the  Redo  button    on 
 

 To undo multiple actions at the same time:

    1. Click the arrow next to the  Undo  button to expand the 
list of your most recent actions.  

   2. Click an action in the list.  

   3. The action you click will be undone, along with a
the actions completed after that. In other words, your 
presentation will revert to the state it was in before at 
action.    

FIGURE PP 0.21

   

      
    try this 



   skill 0.13 Using Find and Replace
   

  0.13 Using Find and Replace 
  The  Find  command in PowerPoint a ws you to locate 
specific instances of text in your presentation. With the 
Find  command, you can find instances of a word or phrase 
throughout a presentation. 

 To find a word or phrase in a presentation:

    1. On the  Home  tab, in the  Editing  group, click the  Find  
button.  

   2. Typ ord or phrase you w t to find in the  Find 
what:  box.  

   3. Click  F e  nd t
or phrase.  

   4. Click  F e   agai    

   The  Replace  command a
of text in your presentat  
text. With the  Replace  comm
phrases one instance at a ti
presentation. 

 To replace instances of a word in a presentation:

    1. On the  Home  tab, in the  Editing  group, click the  Replace  
button.  

   2. Typ ord or phrase you want to change i Find 
what:  box.  

   3. Type the new text you want i Replace with:  box.  

   4. Click the  F e   button to find t rst instance of 
the text.  

   5. Click  Replace  to replace j  

   6. Click  Replace l  to re  

   7. PowerPoint displays a mes
replacements it made. Cl  
appears.  

   8. T Replace  dialo       

FIGURE PP 0.22
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    tips & tricks 
 

   

  try this 
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  0.14 Checking Spelling 
  ork you put into a presenta-

ake the entire presentation 
a l t pplications 
er owerPoin Spell-

 tire presentation for spelling 
nds in a dialog box, enabling 

w to handle each error or type 

 ling errors:

    1.     

   2.  he  Spe g  button.  

   3. ears in the  Spelling  dialog box.  

   4. ions and then select an action:

    ❯  ake no changes to this 
 

   ❯  e no changes to a nstances 
 

   ❯ Click  Add  to make no changes to this instance of the 
word and add it to the main dictionary, so future uses 
of this word will not show up as misspellings. When 
you add a word to the main dictionary, it is available 
for all of t pplications.  

   ❯ Click the correct spelling in the  estions  list, and 
click  Change  to correct just this instance of the 
misspe ing in your presentation.  

   ❯ Click the correct spelling in the  estions  list, 
and click  Chan l  to correct all instances of the 
misspe ing in your presentation.     

   5. After you select an action, the sp ing checker 
automatically advances to the next suspected spelling 
error.  

   6. When the spelling checker finds no more errors, it 
displays a message telling you the check is complete. 
Click  OK  to close the dialog and return to your 

esentation.    

    tips & tricks 
 

 

 

 

 

 

  

  tell me more 
 

  

  

  

  try this 
    

    

FIGURE PP 0.25



   skill 0.15 Saving a Presentation
   

  0.15 Saving a Presentation 
  As you work on a new presentation, it is displayed on-screen 

tored in your computer’s memory. However, it is not 
permanently stored unt ve it as a file to a specific loca-
tion. The first time you save a presentat Save As  di og 
bo  open. Here you can enter a file name, select t
type, and choose where to save the presentation. 

 To save a presentation for t

    1. Click the  Save  button     

   2. The  Save As  di og box ap   

   3.  necessary, navigate to t
save the presentation.  

   4. Click in the  File name:  bo  

   5. Click the  Save  button.    

   The next time you save this presentat e saved with 
the same file name and to the same location automatically. 
The  Save As  di og  not open again. 

 As you are wor g  prese
gh PowerPoin  

not foolpro owe  
may lose a ork done on t  

 FIGURE PP 0.26 
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  tell me more 
 

    1.    

   2.    

   3.  

 

  

   4. 

      

  try this 
 

    ❯           

   ❯       
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  0.16 Using Help 
  m a task, you can look it up 

elp system. The Help system 
laying help topics, including 

os. When Microsoft Power-
ome page displays. From the 

he links to learn more about 
pe nformation, use the 

lp  window. 

 To search for a topic using the Microsoft PowerPoint 
Help system:

    1. Click the  Microsoft PowerPoint Help  button. It is 
located at the far right of t on.  

   2. In the  Type words to search for  box, type a word or phrase 
describing the topic you want help with.  

   3. Click the  Search  button.  

   4. A list of results appears.  

   5. Click a result to display the help topic.    

FIGURE PP 0.27
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  tell me more 
  

 

 

 

  

  try this 
  

    



   skill 0.17 Closing a Presentation
   

  0.17 Closing a Presentation 
   Closing  a presentation removes it from your computer screen 
and stores the last-saved version for future use. If you have not 
saved your latest changes, PowerPoint  prevent you from 
losing work by a ng if you want to save the changes you 
made before closing. 

 To close a presentation and save your latest changes:

    1. Click the  e  tab to open Backstage view.  

   2. Click the  Close  button.  

   3. If you have made no ch g
the presentation, it will  
been made, PowerPoint d
you want to save the chang

    ❯ Click  Save  to save t   

   ❯ Click  Don’t Save 
saving your latest chang   

   ❯ Click  Cancel  to keep t

FIGURE PP 0.28
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  0.18 Exiting PowerPoint 
  icrosoft PowerPoint stays 

esentation to edit or begin a 
 you are finished wor ng on 

he presentation  and  close 
ime. In this ca

 oint. 

 

    1.  stage view.  

   2.     

   3. ave made no changes since the last time you saved 
the presentation, PowerPoint will close immediately. If 
changes have been made, PowerPoint displays a message 
box a ng if you want to save the changes you made 
before exiting.

    ❯ Click  Save  to save the changes.  

   ❯ Click  Don’t Save owerPoint without saving 
your latest changes.       

FIGURE PP 0.29
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Data fi les for projects can be found on 
www.mhhe.com/offi  ce2010skills

FIGURE PP 0.30



  
 powerpoint 2010 

   4. 

       

       

    

      

      

           

   5. 

          

              

   6. 

           

            

           

     
   

           

           

     
   

             

   7. 

       

        

         

   8. 

       

       

       

       

   
 

        

   9. 

        

            
 

        

   10. 

       

       

                     

   
     

       



       

   11. 

      

              

   12.   

         

     
 

   
   

          

   13.   

      

     
 

  

     

         

      

   
    

   14. 

     
     

    

   
 

   
     

   15. 

       

      

    

           

              

   16. 

         

       

     

   

        

       



  
 powerpoint 2010 

       
 

       
    

     

    
    

   17. 

         

          

       

   18.   

   19. 

       

             

  Skill Review 0.2 
 

    1. 

     
 

     

    
 
  

          

          

   2. 

       

       

       

     
 

    
   

      
             

     
     

    

          3. 

       

       

    



       

      

      

           

   4. 

         
  

            

           

     
   

            

   5. 

       

        

         

   6. 

       

       

      
 

     
  

    

            

   7. 

    

   

        

     

    

   

 

         

   8. 

     

      

        

   9. 

    

         
        

FIGURE PP 0.31



  
 powerpoint 2010 

   10. 

        

            
 

        

   11.   

         

     
 

   
   

          

   12. 

     
     

    

    

       

       

         

   13. 

       

      

      

           

          

   14. 

         

          

     

   
 

     

    
    

   15. 

         

          

       

   16.   

   17. 

       

                 



       

  challenge yourself 1 
 

    1. 

          
     

      

   

              

    

      
 

     

    

   

          2. 

      
  

    

   3. 

 

       

    
 

        

   4.   

    
      

 

         

   
 

  

   

            

   5.   

   6. 

FIGURE PP 0.32

  challenge yourself 2 
 

 



  
 powerpoint 2010 

      1.  

   2.  

       3.     
    

     
 

       

   4.   
 

         

FIGURE PP 0.33

   5. 

  

       

 
   

        

   6.   

       
     

  

         

    

       
 

         

   7. 

 

    1. 

    
  

              

   
 

       

  on your own 



       

   2.   
    

   

       3. 

  

    

    
 

        

   4.   

     
        

   
 

   

   
 

         

   5.   

    

   6. 

   

   7. 

 
 

   8.     

   9. 

FIGURE PP 0.34

 

    1.      
      

   2. 

 

   3.  

   4.  

   5.  

   6.          

  fix it 



  
 powerpoint 2010 

   7. 

  

   8. 

 

   9.   

   10. 



  powerpoint 2010 



 Getting Started with 
PowerPoint 2010 

  
  

   introduction 

 Skill 1.1 

 Skill 1.2 

 Skill 1.3 

 Skill 1.4 

 Skill 1.5 

 Skill 1.6 

 Skill 1.7 

 Skill 1.8 

 Skill 1.9 

 Skill 1. 10 

 Skill 1.11   

  In this chapter, you will learn the following skills:  

  skills 

    ❯ Use the different view options 

  ❯ Add slides and sections 

  ❯ Change slide layouts and add 

transitions 

  ❯ Work with the slide master and 

insert headers and footers 

  ❯ Add notes for the speaker to use  

   chapter 1 



   skill 1.1 Introduction to PowerPoint 2010  
   

  Whether used for a sales pitch or as a teaching tool, a mul-
timedia presentation incorporating graphics, animation, 
sound, and video is much more compelling than paper hand-
outs or a “t ng head” lecture. Microsof owerPoint 
2010 enables you to create robust multimedia presentations. 
A  presentation  is made up of a series of  slides.  Each slide 
contains content, including text, graphics, audio, and video. 
You can then manipulate that content by adding transitions, 
animations, and graphic effects. Before diving in and creating 
a presentation, you should f iliarize yourself with some of 
PowerPoint’s basic features. 

 When you first start PowerPoint, you will notice the pre-
sentation window is divided into three areas:

    Slides and Outl e Tabs —Displa l the slides in the 
presentation. The Outline tab displays only the text 
content of slides. The Slides tab displays thumbnail 
images of slides.  

   Slide P  —Area where you can modify slides, including 
adding and formatting text, images, SmartArt, tables, 
charts, and media.  

   Notes Pane —Area where you can type notes about the 
current slide displayed in the Slide pane. The text you 
type in the Notes pane will not appear when you play your 

presentation. T  
for your audience or can be
presentation.   

Each slide contains  placehol  
including

Title —Use to display the t
title for the slide.  

Subtitle —Use to display t   

Text —Use to add tex
points brief, and use bu  

SmartArt —Use to add a S
SmartArt displays lists in
including, processes, c
matrices.  

Gr c —Add clip ar
slides.  

Charts and Tables —Org
table to give your audie  

Media Clips —Add sou
presentation.        

  1.1 Introduction to PowerPoint 2010 

 FIGURE PP 1.1 

Titl

Te
Graphic

Notes Pane

Slide Pane

Slides and Outline Tabs

Presentations can be simple or complex, but they all follow some 

basic steps.

   1.  Plan your presentation —Decide what you want 

to include and in what order you want to present the 

information.  

   2.  Create your slides —You can create slides from 

sophisticated templates,

add formatting and effects to give your presentation a 

unique look.  

   3.   

errors. Y

your presentation.  

 4.  Practice —Pr

in front of an audience.
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  ys to view your presentation: 
eading view, and Slide Show 

Normal view r  typically create 
Slide Sorter view  displays thumbnail 

esentation and is useful in re-
 a presentation.  Reading view

tation within the PowerPoint 
  Slide Show view  displays your slides fu

r presentation the way your 
 

 etween views is to click one 
 the right side of the status bar, 

  

 Click the Normal view button to add or edit content.

 Click the Slide Sorter view button to view 
thumbnails of your presentation.

 Click the Read g view button to view your 
presentation within the current PowerPoint window.

 Click the Slide Sh w button to view your 
presentation at full screen as your audience will. To exit 
Slide Show view, press the q key on the keyboard.  

  1.2 Understanding Views 

 FIGURE PP 1.2 

Normal View

 FIGURE PP 1.3 

Slide Sorter View



   skill 1.2 Understanding Views  
   

tips & tricks
 

 

 Zoom 

Bar 

 

tell me more

Notes Page view 

 

  

Master views 

 

 

try this
 ❯     

   

 ❯   

  

    

 FIGURE PP 1.4 

Reading View

FIGURE PP 1.5

Slide Show View
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  nt includes the Outline tab 
avigate between and work 

Slides tab splays thumbnails of all your 
avigate between slides, 

eview and edit content. In 
cific slide, it must first be dis-

 Slides tab:

    1.  isplayed.  

   2. ide you want to display.  

   3.  pane ready for editing.    

 To edit text on a slide:

      1. Click the placeholder with the text you want to change.  

   2. Click and drag across the text to select it.  

   3. Type the new text for the placeholder.  

   4. Click outside the placeholder to deselect it.      

  1.3 Using the Slides Tab 

tips & tricks
 

 

 

tell me more
 

 

try this
 

 ❯      

  

 ❯       
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Slides Tab

Select the placeholder 

and text to edit.

appears in

the Slide pane.

ide 2 is clicked

on the Slides tab.



   skill 1.4 Using the Outline Tab  
   

  When working on a presentation it’s easy to focus on the 
graphic elements of your slides. Adding graphics, transitions, 
and animations may seem important, but the foundation of 
an effective presentation is a focused message. When work-
ing with text on slides, it is a good idea to keep the amount of 
text on each sl d and to concentrate on one clear 
message per slide. The  Outline tab  displays the text from your 
slides in outline view, a wing you to concentrat t 
aspect of your slides without being distracted by the graphic 
elements. U Outline tab to enter and edit your text 
directly in the outline. 

 To use the Outline tab:

      1. Click the tab labeled  Outl    

   2. Click in the text you want  

   3. Type the new text for t  

   4. Click the tab labeled  Sl    

   5. View the text you added i        

  1.4 Using the Outline Tab 

tips & tricks
 

 

 

 

tell me more
 

 

 FIGURE PP 1.7 

Outline Tab

tline Text of Slides
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  ral sl led with text and 
mplate, your presentat  

tent. But what 
mation to your presentation? 
owerPoint makes it easy. 

 :

      1.    group, click the  New 

  

   2. New Slide  gallery.  

   3. Add your content to the slide.  

   4. Continue adding and modifying slides until your 
presentation is complete.          

  1.5 Adding Slides to Presentations 

tips & tricks
  

 

 

tell me more

try this
 

 ❯       

 ❯       

  

 

 FIGURE PP 1.8 

w Slide 

ton arrow

A youts 

appear in the gallery



   skill 1.6 Adding Sections to Presentations  
   

  As you work on a presentation and add more slides, you may 
find it difficult to find a specific slide using the  Slides  tab. 
Scro ing through 20, 30, or even 40 thumbna nd the 
content you are looking for is not a very efficient way to work. 
PowerPoint 2010 includes t ity to add  sections  to your 
presentation. You can use sections to create smaller groups of 
slides within your presentation to help you better organize 
your work ter you have added sections to your presenta-
tion, you can then hide and show the slides’ th bnails by 
expanding and collapsing the sections. 

 To add a section to a presentat

      1. On the  Slides  tab, cl
for the section you wan  

   2. On the  Home  tab, in the     
button and select  Add Se    

   3. PowerPoint creates a ne  

   4. To collapse the sect
triangle next to the sect
and show the slides, click t        

  1.6 Adding Sections to Presentations 

tips & tricks
 

 

  

  

  

  

 

tell me more
 

  

 

  

  

try this
 ❯    

    

 ❯   

   

 FIGURE PP 1.9 

Select Add Section to add a new 

section to the presentation.

Click the triangle next to the section 

name to show and hide the section.
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  esentation, you can modify 
ndividual sl  you add 

nt to change the layout of the 
tent. PowerPoint comes 

se. Choose the one 
ide. 

 To change the slide layout:

      1. Select the slide you want to change.  

   2. On the  Home  tab, in the  Slides  group, click the  Slide 

Layout  button.  

   3. Select a slide layout from the  Slide Layout  gallery.          

  1.7 Changing Slide Layouts 

tips & tricks
 

   

 

tell me more
 

Slide Library  

 

 

 

try this
 

  

FIGURE PP 1.10

Layout button. yout to apply 

it to the slide

The current layout 

is highlighted.



   skill 1.8 Applying Slide Transitions  
   

  A  transition  is an effect that occurs when one slide leaves the 
screen and another one appears. Transitions add movement 
to your presentation and can keep audiences interested, but 
remember that overusing transitions can be distracting. Add 
transitions only where they  improve your presentation. 

 To apply transitions to a slide:

      1. Sele ide to which you w t to add the transition.  

   2. Click the  Transi ons  tab.  

   3. In the  Transition to This Slide  group, click the  More  
button and select a transition to ap ide.  

   4. PowerPoint automatical
you.  

   5. Click the  Pre w  bu   

   6. To add a sound effe
the  Sound:  box.  

     7. To add the same transit
presentation, select the sl  
to apply, and cl A           

  1.8 Applying Slide Transitions 

tips & tricks
 

 

 ❯     

  

  

 ❯    

  

    

tell me more

 

 

 

 

try this
 

 

  

 FIGURE PP 1.11 

Select a transition 

from the gallery.

Transitions T
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  slide master  a slide template that is used 
reate a consistent look 

sy to create a standard look 
ion by contro ing layouts and 
ounds and themes, at the pre-
he slide level. When you use 
n your presentation, you only 
r in Slide Master view to make 

esentation. 

 :

      1.     

   2.  ick the  Slide Master  button.  

   3. aster view. Here you can 
w layouts to the existing 
dify the slide master or 

ide master.  

   4. w  button to return to 

 When you are in Slide Master view, you will notice the 
second tab on t on is no longer the  Home  tab, but rather 
the  Slide Master  tab. The  Slide Master  tab contains the com-
m or ng with the slide master. Spe , the  Edit 
Master  group gives you acces lowing commands:

sert Slide Master —Presentations can have more than 
one slide master. To add another slide master, switch 
to Slide Master view. On the  Slide Master  tab, click the 

sert Slide Master  button.  

sert Layout —Each slide master contains seve youts 
that appear in the  New Slide  gallery in Normal view. Click 

sert Layout  button to add a layout to the master.  

Delete Slide —Click the  Delete Slide  button to remove a 
slide master or layout from the presentation.  

Preserve —Click the  Preserve  button to change a master 
so tha l always be part of the presentation, even if it 
is not being used. When a master is preserved, a pushpin 
icon a ears next to the slide.        

  1.9 Working with the Slide Master 

tips & tricks
 

 

tell me more

  Handout 

masters 

  Notes masters 

 

try this
  

 ❯       

   

 ❯        

 FIGURE PP 1.12 

The slide master contains the slide 

layouts used in the presentation.

Edit Master Group

Slide Master Tab Close Master View Butt



   skill 1.10 Inserting Headers and Footers  
   

Headers  and  footers  are text that appear on every slide or 
handout. Typically, headers appear a t 
and footers appear at the bottom. Slides only display footers. 
Use footers when you want to display the same text on every 
slide, such as the name of your company. When you add foot-
ers to the slide master, they are automatically added to every 
slide in the presentation. 

 To add text to the footer of all the slides in a presentation:

      1. Verify that the slide master is selected.  

   2. Click the  Insert  tab.  

   3. In the  Text  group, click the  Header & Footer  button.  

   4. On the  Slide  tab of the  Header and Footer  d g box, 
select the  Footer  check box.  

   5. Type the text for the foote    

   6. Click the  Apply  bu
master.    

Note:  In order to ch ge t
with a slide master, you must u    
box. Adding text to the footer  

l not change the footer
slide master. 

 ant a certain layou
select the layout you w t
Header and Footer  dialog box.
be sure to click the  Apply 
button.     

  1.10 Inserting Headers and Footers 

tips & tricks
 ❯     

    

   

  

  

 

  

 ❯   

    

 ❯   

    

tell me more
  

  

 

 

try this
 

   

 

 FIGURE PP 1.13 

 eClick Apply to add to 

selected layout only.

Header & Footer Button

Footer Check Box

ooter Text Box

ab

to all slides d Click Apply to All to a

Master.lidassociated with the S
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Speaker notes ides. They 
esentation. Sp er notes can 

o to a certain slide in the 
pecific detail that may not be 

 

    1. ew.  

   2. Click in the  Notes  pane. This is pane at the bottom of the 
screen with the text  Click to add notes.   

   3. Type your note for the slide.      

  1.11 Adding and Printing Notes 

 d to create handouts for your 
r speaker notes and distrib-

he Notes view a ws you to 
l look when printed. In Notes 

pears at the top of the screen 
rectly below the slide. You can 
iew, but you cannot edit the 

 To switch to Notes view:

      1. Click the  View  tab.  

   2. he  Presentation Views  group, click the  Notes Page  
button.  

   3. PowerPoint displays your presentation in Notes view.  

   4. Select the speaker notes text and format the text as you 
want it to appear when printed.      

 FIGURE PP 1.14 

T our speaker notes 

in the Notes Pane.



   skill 1.11 Adding and Printing Notes  
   

 To print your speaker notes:

      1. Click the  File  tab.  

   2. Click the  Print  tab in the  Backstage  view.  

   3. Click the first option under  Slides:.   

   4. Under  Print Layout,  click     

   5. Click the  Print  button.           

tips & tricks

 

  

tell me more
Notes master view 

 

 

try this
 

  from the perspective of . . . 
 TEACHER 

 

  

 FIGURE PP 1.15 

es Page Button

w Tab

Slide

Note
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Skill 2. 1 

Skill 2.2 
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In this chapter, you will learn the following skills:

skills

 ❯ Work with text within slides 

including adding text, formatting 

lists, and using outlines

 ❯ Organize text with WordArt, the 

content placeholder, and tables

 ❯ Add interest through charts, 

SmartArt, and shapes with text

 ❯ Add graphics including clip art 

images, screenshots, and pictures

 ❯ Add media to slides including 

sounds and movies

Adding Content to Slides

chapter 2



   skill 2.1 Adding Text to Slides  
   

A good presentation consists of a balance of text and graph-
ics. It is important to remember to keep text brief. Short, clear 
points convey your message to your audience better than 
rambling paragraphs of text. You can add text to slides by 

using text placeholde
predefined areas in slide la
boxes are boxes tha  
where you want it.

2.1 Adding Text to Slides

To add text to a text placeholder, click inside the text 
placeholder and type the text you want to add. Click outside 
the placeholder to deselect it.

To add a text box:

 1. Cl sert tab.

 2. Text group, cl

 3. Click on the slide wher

 4. Type your text.

 5. Click outside the text bo

tips & tricks tell me more

 

 

 

 

try this

FIGURE PP 2.1

Text Placeholder

Text B x

FIGURE PP 2.2

x  x 
ab
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sts to organize your informa-
Bulleted lists are used to organize 

e displayed in a particular 

order, such as features of a product. Numbered lists are used 
to organize information that must be presented in a certain 
order, such as step-by-step instructions.

2.2 Adding Bulleted and Numbered Lists

FIGURE PP 2.3

Bulleted List

Numbered List



   skill 2.2 Adding Bulleted and Numbered Lists  
   

To add a bulleted list to a slide:

 1. Select the text you want to display in a list.

 2. On the Home tab, in the Para aph group, click the 
arrow next to the B lets button.

 3. Select a bullet style from the g lery.

To add a numbered list to a sl

 1. Select the text you want

 2. On the Home tab, in the P
arrow next to the N er

 3. Select a numbering style fr

tips & tricks

 

multilevel list

 

   

  

tell me more

 

try this

 ❯ 

 ❯ 

 ❯ 

FIGURE PP 2.4

 ton on
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esentation, you ma nd 
 a Word document and then 

ing styles in the Word 
ten l convert to a presen-

ach Heading 1 style becomes 

the title on the slide, and each Heading 2 style becomes the 
main text ter you have save ord docu-
ment, you can then import the content, creating the base 
slides for your presentation.

2.3 Opening a Word Outline as a Presentation

FIGURE PP 2.5

o become slide title.

o become slide text.

FIGURE PP 2.6

 title.idtyle becomes sl

Heading 2 s omes slide text.



   skill 2.3 Opening a Word Outline as a Presentation  
   

To insert slides from a Word outline:

 1. Click in the presentation where you want to insert the 
slides.

 2. On the Home tab, in the Slides group, click the arrow 
below the New Slide button and select Slides from 

Outline . . .

 3. he Insert Outline dialo
to insert.

 4. Click the Insert button.

 5. The slides are added to t
heading styles in the Wor

tips & tricks

 

tell me more

FIGURE PP 2.7

Click Slides from Outline . . . to create 

new slides based on a Word document.

New Slide Button

me Tab
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nt  that you add to 
 by using character cts, or if 

t, you can use WordArt. 

Word t Quick Styles are pre ned graphic s pply 
to text. These styles include a combination of color t-
li cts.

2.4 Adding WordArt to Slides

FIGURE PP 2.8

 1. 

 2. WordArt button and select a 
y.

 3. Replace the text “Your Text Here” with the text for your 
slide.

This text was created with WordArt.

FIGURE PP 2.9

Insert Tab
 

WordArt Gallery



   skill 2.4 Adding WordArt to Slides  
   

ter you have added WordArt to your document, you 
can modify it just as you would any other text. Use the Font
box and Font Size box on the Home tab to change the font or 
font size of WordArt.

In previous versions of Microsof ordArt came 
with a pre ned set of graphic styles that could be for-
matted, but on a very limited basis. Beginning with Power-
Point 2007, WordArt was changed to allow a wide range of 

stylization. When you add Wo
slide, the Drawing Tools Forma  
tab appears. In the WordA
you can apply Quick St
Art, or modify it further by
text l, text outline, and text

tips & tricks
 

tell me more

 

 

 from the perspective of . . . 
DENTAL HYGIENIST  
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lance of text, graphics, 
. The content placeholder is a 

ives you a quick way to add a 
ntations owerPoint, you 

nt to your slides through the 

To add content to a slide through the content placeholder:

 1. Click the icon of the type of content you want to add.

 2. The associated di og box or task pane appears.

 3. Add the content in the same manner as if you accessed 
the command from t on.

2.5 Understanding the Content Placeholder

tips & tricks

FIGURE PP 2.10

Click an con to add content to the slid



   skill 2.6 Creating Tables in Presentations  
   

When you have a large amount of data on one slide, you will 
want to organize the data so it is easier for your audience 
to understand. A table helps you organize information for 

ctive display. Tables are organized by rows, which display 

horizonta , and columns, wh
section of a ro cell

can be used to display everyth
sales numbers to product inve

2.6 Creating Tables in Presentations

To add a table to a slide:

 1. Cl sert tab.

 2. Click the Table button.

 3. Select the number of cells you want by moving the cursor 
across and down the squares.

 4. When the description a he menu displays the 
number of rows and columns you want, click the mouse.

 5. The table is inserted into your presentation.

FIGURE PP 2.12

sert Tab

Table Button

 cursor across e your

es.

Row

Cel

Column

FIGURE PP 2.11

tell me more

 

 

try this

 ❯ 

 ❯  
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esentat ant to 
isual way possible. One way to 
sing charts. A chart takes the 
n a spreadsheet and converts 

 PowerPoint, you can create a 
g bar charts (b tack and 

tter charts, and line charts.

To add a chart to a presentation:

 1. Click the sert tab.

 2. he Illustrations group, click the sert Chart button.

 3. he Insert Chart dialog box, click a chart type category 
to display that category in the right pane.

 4. Click a chart type in the right pane to select it.

 5. Click OK to add the chart to the slide.

2.7 Adding Charts to Slides

tips & tricks
 

 

tell me more

try this

 

FIGURE PP 2.13

Insert Chart Buttonsert Tab

FIGURE PP 2.14

Click a chart type in the right pane.

Click a chart category to 

y it in the right pane.

     Click OK to insert the chart



   skill 2.8    

SmartArt is a way to take your ideas and mak m visual. 
Where presentations used to have plain bulleted and ordered 
lists, now they can have Smart t. SmartArt images are 
visual diagrams containing graphic elements with text boxes 
in which you enter information. Using SmartArt not only 
m es your presentation look better but helps convey the 
information in a more meaningful way.

There are eight categories of SmartArt for you to choose 
from:

List—Use to list items that do not need to be in a 
particular order.

Process—Use to list items that do need to be in a 
particular order.

Cycle—Use for a process that repeats over and over again.

Hier chy—Use to show branching, in either a decision 
tree or an organization chart.

Relationship—Use to sho

Matrix—Use to show ho

Py id—U stra
other with the largest item
sm lest item being on t

Picture—Use to show a ser  
in the diagram.

To insert a SmartArt diag :

 1. Click the Insert tab.

 2. In the Illustrations grou  

Graphic button.

 3. Choose a SmartA
SmartArt graphic t e.

 4. Click OK.

 5. The SmartArt diag

2.8 Adding SmartArt to Slides

tips & tricks

 

tell me more

 1. 

 2. 

 

try this

 

FIGURE PP 2.15

ab Insert SmartArt Button

FIGURE PP 2.16

Select a graphic from the list

to display it in the right pane.

Click a SmartArt category 

to display it in the list.

Cl k OK.
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shape at you can qu r 
Shapes gallery gives you access 

r presentation.
apes that you can add to 

Lines

Rectangles

Basic Shapes

Block Arrows

Equation Shapes

Flowcharts

Stars and Banners

Callouts

Action Buttons

To add a shape to a slide:

 1. Click the sert tab.

 2. he I ations group, click the Shapes button and 
select an option from the Shapes ga ery.

 3. The cursor changes to a crosshair .

 4. Click an here on the document to add the shape.

2.9 Adding Shapes to Slides

tips & tricks

 ❯   

 ❯  

 

 ❯ 

 

tell me more

 

 

try this

FIGURE PP 2.17

Illustrations Group

Shapes Butt

Shapes Gallery



   skill 2.10 Adding Text to Shapes  
   

One way to bring attention to text on a slide is to include it 
as part of a shape. A shap l draw your audience’s focus to 
whatever text you add to it. When you add a shape to a slide, 
the shape behaves as a text box. l you need to do to add text 
to the shape is begin typing. You can also g t 
to shapes that you previously added to a slide.

To add text to an existing shap

 1. Select the shape you want

 2. Type the text you wan

 3. Click out ape.

tips & tricks tell me more
 

  

  

 

 

try this

 

2.10 Adding Text to Shapes

FIGURE PP 2.18

Select the shape you want to add text to.

ext you want to add to the shape.
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 clip art llows you to insert clips into 
nclude images, photographs, 

nd, and video. By default, 
s embedded objects, meaning 
ntation (changing the source 

w document). The Clip 
ch for differen nds of clips 

 1. 

 2. he Clip Art button.

 3. The Clip Art task pane appears.

 4. Type a word or phrase describing the clip you w t to 
add in the Search for: box.

 5. Click the Go button.

 6. Click the clip you want to add it to the slide.

2.11 Adding Clip Art Images to Slides

tips & tricks tell me more
 

try this

 

 

FIGURE PP 2.19

ip Art Button

ab

Go Button

Clip Art Task Pane

Type search word here.

Click a thumbnail to insert it.



   skill 2.12 Adding Screenshots to Slides  
   

A screenshot captures the image on the computer screen 
(such as an application’s interface or a Web page) and creates 

mage that can then be used just as any other drawing or 
pictur evious versions of PowerPoint, you had to 
use another application to create the screenshot and then 
insert the image through PowerPoint. In PowerPoint 2010, 
you can now use the Insert Screenshot command to capture 
and insert screenshots into presentations all from within the 
PowerPoint interface.

To add a screenshot to a prese

 1. Click the Insert tab.

 2. he Images group, cl

 3. The Available Windows se
image of each of the curre

 4. Click a thumbna
to the presentation.

2.12 Adding Screenshots to Slides

tips & tricks tell me more

 

 

FIGURE PP 2.20

sert Tab

Screenshot Button

Av s
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lustration to a slide 
han text alone. Use the Insert 

res that you created in 
d from your smart phone or 

tation.

 1. 

 2. he Images group, click the Insert P m File 
button.

 3. The Insert Picture dialog box opens.

 4. Navigate to t cation, select t ick 
Insert.

tips & tricks
 

tell me more

 

 

try this

 

2.13 Adding Pictures to Slides

FIGURE PP 2.22

FIGURE PP 2.21

ab

    Insert Picture from File Button

Navigate to the location you want.

Select the file you want to insert.

Click the Insert Button.



   skill 2.14 Adding Sounds to Slides  
   

Sound files, such as music or sound effects, can enhance your 
slides, ma n m more engaging to your audience. You can 
add sounds to your presentation from the Clip Organizer, 
fr ave downloaded fr ternet, or from 

’ve recorded yourself.

To insert a sound:

 1. Click the sert tab.

 2. he Media group, click t

 3. he Insert Audio dialo
you want and click the sou

 4. Click sert to add t

tips & tricks

 

 

tell me more

 

 

 

 
try this

2.14 Adding Sounds to Slides

FIGURE PP 2.24

Click Insert.

lect the sound fil

FIGURE PP 2.23

nsert Tab ton
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movie hat includes moving images 
e digital movies ready to go, 

r presentation.  you don’t 
t comes with preset sound and 

esentation.

 1. 

 2. sert Video button.

 3. Insert Video d g box, browse to find the file you 
want and click the mov ct it.

 4. Click sert to add the mov nto your presentation.

tell me more try this

 ❯ 

 ❯  

2.15 Adding Movies to Slides

FIGURE PP 2.25

nsert Tab t

FIGURE 2.26

Click Insert.

Select the video file.
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Skill 3. 1 

Skill 3.2 

Skill 3.3 

Skill 3.4 

Skill 3.5 

Skill 3.6 

Skill 3.7 
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Skill 3.9 

Skill 3. 10 

Skill 3. 11 

Skill 3. 12 

Skill 3. 13 

Skill 3. 14 

Skill 3. 15 

Skill 3. 16 

Skill 3. 17 

 ❯  Change themes and theme 

effects

 ❯  Apply Quick Styles to text boxes, 

tables, and shapes, and adjust the 

layout of SmartArt

 ❯  Show the ruler and gridlines, and 

change placeholder size

 ❯  Edit image alignment, grouping, 

rotating, and sizing

 ❯  Apply animation effects

chapter 3
Formatting Presentations

skills

In this chapter, you will learn the following skills:

introduction



   skill 3.1 Changing the Presentation Theme  
   

3.1 Changing the Presentation Theme
A theme is a group of formatting options that you apply to 
a presentation. Themes include font, color, and effect styles 
that are applied to specific elements of a presentation. In 
PowerPoin nclude background styles. When 
you apply a theme, all the slides in the presentation are 
affected.

To apply a theme to the prese

 1. Click the Design tab.

 2. he Themes group, cl

 3. Select an option in the Th

 4. he slides in your prese

tell me more

 

 

 

 

 

try this

FIGURE PP 3.1

Design Tab
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3.2 Changing the Color Theme
mportant to choose col-

oor color choices can detract 
g to convey in your presenta-

e too muted, your presenta-
ose are too harsh and 

ntation may seem busy and 

er of color themes for 
color theme at com-

ned to work w n a presen-
ge the color of backgr  

placeholders, text, tables, charts, Sm tArt, and drawing objects 
in a presentation. When you ap eme to a presentation, 
this includes a color theme, which includes default theme col-
ors for presentation elements. Y ange the color theme 

ct g the other components of the theme.

To apply a color theme to a slide master:

 1. Cl Design tab.

 2. he Themes group, cl Theme Colors button.

 3. Select a color theme from the list that appears.

tips & tricks

  

tell me more

 

try this

FIGURE PP 3.2

ab

Themes Gr

Theme Colors Gallery



   skill 3.3 Changing the Theme Effects  
   

3.3 Changing the Theme Effects
owerPoint 2010, you can add graphic effects to drawing 

objects and text. These graphic effects give you the ability 
to create dynamic images without the help of a professional 
designer. You can create sophisticated fills for objects and 
control the shape outline for objects, including the color, 
weight, and line style.

Using these ne cts can be overwhelming at first. How 
w which effects go w gether? A part of a pre-

sentation’s theme is the theme effects. The theme effects 

consist of li ct
your slides, giving you a starti
images in your presentations.

To ap me effects to t

 1. Click the Design tab.

 2. Themes group, cl

 3. Select a theme effect fr

tell me more

  

try this

FIGURE PP 3.3

Design Tab

Themes Gr

Theme Effects Gallery
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3.4 Changing the Slide Background
background ment tha ls a slide. Back-

tures, or even images. Each 
ariety of background styles 

nd styles acquir r colors 
ge in color from light to 

mes also include different 
g on the theme you choose. 

esentation the default back-
r slides. To change just the 
esentat r 

theme elements such as fonts), you should change the back-
ground style for the presentation.

To change the background style:

 1. Click the Design tab.

 2. he Back ound group, click the Bac tyles 
button.

 3. Select an option fr Back ound Styles gallery.

tips & tricks

 

 

 

tell me more
 

try this

FIGURE PP 3.4

ab

Backgr



   skill 3.5 Changing Fonts  
   

3.5 Changing Fonts
A font, or typeface, refers to a set of characters of a certain 
design. The font is the shape of the character or n er as it 
appears on-screen. You can change the look of text by chang-
ing the font, the font size, or the font color.

To change the font:

 1. Select the text to be changed.

 2. On the Home tab, in the Font group, click the arrow next 
to the Font box.

 3. Scrol ist to find the new font.

 4. Click the font n

To change the size of the text:

 1. Select the text to be changed.

 2. On the Home tab, in the Font group, click the arrow next 
to the Font Size box.

 3. Scroll the lis nd t

 4. Click the size you want.

To chang he text

 1. Select the text to be chang

 2. On the Home tab, in the 
to the Font Color button.

 3. Click the color you want.

tips & tricks tell me more

  

 

try this

FIGURE PP 3.5
ab

Click the Font Size arrow.

nt or utton
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3.6 Changing the Look of Text Boxes
Text boxes rs that allow you to place text 

rst add a text box to a slide, 
t from the theme and has no 
ant the text in a text box to 
stomize the look of the text 

ap cts.

x:

 1. t to change.

 2. r Drawing Tools.

 3. t box:

 a. p, click the Shape l button.

 b. he color palette.

 4. t box:

 a. p, click the Shape Outl e 

 b. Select an option from the color palette.

 c. Point to Wei t and select a th s option for the 
outline.

 d. Point to Dashes and select a dash style for the 
outline.

 5. To change the shape effects on a text box:

 a. he Shape Styles group, click the Shape E s 
button.

 b. Point to Presets and select a predetermined 
combination of shape effects.

 c. Point to any other options on the menu to choose 
from a variety of shadow, r ction, glow, soft edges, 
bevel, and 3-D rotation effects.

tips & tricks

 

 

 

 

tell me more
 

 

 

 

FIGURE PP 3.6

awing Tools Format Tab

Select a Quick Style from the 

Shape Styles gallery.

A Quick Style applied to a text box.



   skill 3.7 Text Boxes  
   

3.7 Applying Quick Styles to Text Boxes
Quick Styles are a combination of formatting that give ele-
ments of your presentation a more polished, graph ok 
without a lot of work. Quick Styles can be applied to text 
boxes and include a combination of borders, shadows, r c-
tions, and picture shapes, such as rounded corners or skewed 
perspectiv stead of applying each of these formatting ele-
ments one at a time, you can apply a combination of elements 
at one time using a preset Quick Style.

To apply a Quick St

 1. Select the text box you wa

 2. Click the Format tab u

 3. he Shape Styles grou

 4. Shape Styles ga ry
to the text box.

tips & tricks tell me more

 

 

  

try this

FIGURE PP 3.7

ton

Shape Outline Button

ffects Button

A blue fill color eset shape effects 

combination have been applied to the text box.
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3.8 Applying Quick Styles to Tables
matting to text boxes using 
lso apply complex format-

ables. With Quick Styles 
orders and shading for a table 
r table a professional, sophisti-
k.

To apply a Quick Style to a table:

 1. Click the Design tab under Table Tools.

 2. he Table Styles group, click the More button  .

 3. he Table Styles g lery, click a Quick Style to apply it 
to the table.

tips & tricks tell me more

 

 

  

 

try this

FIGURE PP 3.8

Select a Quick Style from 

the Table Styles gallery.



   skill 3.9    

3.9 Using the Shape Styles Gallery
Once you have added a basic shape to a slide, you can apply 
complex formatting and styles to the shape. You can change 
t l or outline color using one of the colors from your pre-
sentation’ me. Y ange the shap cts, apply-
ing shadows, r ctions, glows, and 3-D effects to the shape. 
Bu siest way to format a shape is to apply a Quick Style. 
The Shape Styles g lery includes a number of Quick Styles, 
m ng it easy for you to apply complex formatting to shapes.

To apply a Quick Style to a sh

 1. Click the Format tab u

 2. In the Shape Styles grou

 3. I Shape Styles ga ry
to the shape.

FIGURE PP 3.9

tips & tricks
 

tell me more

 

 

try this

Drawing Tools Format Tab

A Quick Style has been

o these shapes.

Click an option in the 

Shape Styles gallery.
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3.10 Changing the Layout of SmartArt
d to display spe ypes of 
martArt diag ncludes a 
ta to. But what if your infor-

yout? Or what if you want 
es? You can use the SmartArt 
pes and promote and demote 

To change the layout of a SmartArt diagram:

 1. On the Design tab under Table Tools, in the Create 
Graphic group, cl Add Shape button and select an 
option for adding a shape.

 2. Click the Demote Selection button to move the new 
shape down one level in the diagram org ization.

 3. Click the Promote Selection button to move the new 
shape up one level in the diagram organization.

artArt diagram to your slide, 
t would convey your informa-

ay have initially chosen a list 
ycle diagram is more appro-

ange the diagram lay-
ntire diagram over again.

To change the diagram type:

 1. On the Design tab under Table Tools, in the Layouts 
gallery, click the More button to display the fu  g lery 
of layouts.

 2. Click an option in the gallery to convert the selected 
Smart t diag nto the new layout.

FIGURE PP 3.10

ap ton

Demote Selection Button

FIGURE PP 3.11

Click an option in the gallery to convert the 

SmartArt diagram into the new layout.

tips & tricks

 

try this



   skill 3.11 Using the Pictur
   

3.11 Using the Picture Styles Gallery
When creating a presentation, you want to grab the audi-
ence’s attention. What makes one presentation st t 
from another isn’t necessarily the content of the slides, but 
the graphics used to convey that content. PowerPoint comes 
with a number of picture Quick Styles you can apply to 
images, instantly giving them a more sophisticated look. Pic-
ture Quick Styles include a combination of graphic effects, 
such as borders, shadows, 3-D rotation, and r ctions.

To apply a picture Quick St

 1. Click the Format tab u

 2. he Picture Styles grou

 3. he Picture Styles g ler
to the shape.

FIGURE PP 3.12

tips & tricks

 

tell me more

 

try this

allery to apply 

the Quick Style to the picture.
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3.12 Showing the Ruler and Gridlines
n your presentation, align-

e the difference between 
hat looks thrown together. 

idlines as visual tools to check 
hics on your slides. The ruler 
ment of text in placeholders, 

Gridlines are a series of dotted 
at divide the slide into small 

igning placeholders and 

To display gr ines in PowerPoint:

 1. Click the View tab.

 2. he Show group, click the Gridlines check box to 
select it.

To display the ruler in PowerPoint:

 1. Click the View tab.

 2. he Show group, click the r check box to select it.

tips & tricks

 

tell me more

 

try this

 1. 

 2. 

FIGURE PP 3.13

The ruler is displayed.
Use gridlines to align

objects on a slide.



   skill 3.13 Changing the Size of Images  
   

3.13 Changing the Size of Images
Whe rst add an image to a slide, more than likely it is 
not the size you w t. It r be too small or too large. 

owerPoint, you can resize images using the resize handles 
that appear at the corners and sides of an image when it is 
selected.

To resize an image using the drag method:

 1. Point to one of the resize ha  on the image.

 2. When the mouse chang
g the mouse:

 ❯ Drag the mouse towar
m e it smaller.

 ❯ Drag the mouse away fr
make it larger.

 3. Whe mag
button.

tips & tricks

 

tell me more

 

 

  

try this

FIGURE PP 3.14

Resize width and height.

size width

esize height.
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3.14 Changing the Size of a Placeholder
placeholder ide that holds text or 

art, or image. Placeholders 
hat does not display in the 

g. You can use t teps 
age to change the size of a 

r:

 1. a  on the placeholder.

 2. When the mouse changes to the resize cursor  , click 
g the mouse:

 ❯ Drag the mouse towar nter of the placeholder 
to make it smaller.

 ❯ Drag the mouse away from the center of the 
placeholder to make it larger.

 3. When the placeholde t, release the 
mouse button.

tips & tricks
 

tell me more
 

 

try this

FIGURE PP 3.15

Resize width and height.

esize width.

esize height.



   skill 3.15 Aligning, Grouping, and Rotating Images  
   

3.15 Aligning, Grouping, and Rotating Images
When designing a presentation, it is important to place your 
graphics so that the ave the most impact on your audi-
ence. Any graphics that appear in a straight line should be 

igned, to ensure at they are precisely placed. On the other 
hand, you may want to rotate one graphic to make it stand 
ou ide. Y ct multiple images on a slide 
and group them together, thus turning multiple objects into a 
single object that you can easily move, rotate, or resize as one.

To align graphics on a slide:

 1. Click the Format tab under Picture Tools.

 2. he Arrange group, click the ign button and select 
an option:

 ❯ The ign Le gn Center, and i t 
ig aph g an invisible vertical line.

 ❯ The ign T ign Middle, and ign Bottom 
commands align graphics along an invisible horizontal 
line.

 ❯ Click the ign to Slide option to align graphics 
along the edges and center of the slide, rather than 
relative to each other.

 ❯ The Distribute Horizontally and Distribute 
Vertically options evenly space the graphics on the 
sl  order to use these options, the ign to Slide 
option must be active.

To rotate graphics on a slide:

 1. Click the Format tab u

 2. he Arrange group, cl
an option:

 ❯ Rotate Left 90º—rotat
counterclo

 ❯ Rotat t 90º—rot
clo

 ❯ Flip Horizontal—r
vertical axis.

 ❯ Flip Vertical—r ct
horizontal axis.

To group graphics on a slide:

 1. Select the graphics you w

 2. Cl Format tab u

 3. Arrange group, cl
an option.

FIGURE PP 3.16

Rotate Button

These three pictures have been 

grouped into a single object.
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tips & tricks
 

 

tell me more

try this

 1. 

 2. 

from the perspective of . . .
RETAIL MANAGER
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3.16 Applying Animation Effects
Adding animations to slides can help emphasize important 
points and grab your audience’s attention. In PowerPoint 
you can animate individual objects on a slide, including text, 
images, charts, tables, and SmartArt.

There are four basic types of animation schemes:

Entr — imates the object coming on to the slide; 
starts with the object not visible and ends with the object 
visible. Examples of En ance animations include Fade In, 
Split, Fly In, and Appear.

Emphasis— imates the object on the screen. Examples 
of Emphasis animations include Pulse, Spin, Grow/Shrink, 
and Teeter.

t—animates the object leaving the slide; starts with 
the object visible and ends with the object not visible. 

Examples of Exit animat   
Float Out, Wipe.

Motion Pa —animates t
line. Examples of Motion P  
Arcs, and Loops.

To add an animation to an obj

 1. Select the object you wan

 2. Click the ations tab.

 3. he Animation group, cl

 4. he Animation g lery,
the object.

tips & tricks try this

FIGURE PP 3.17

Animations Tab

Select an animation from the

gallery to apply to the object.
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3.17 Modifying Animations
h a n er of easy-to-use, 

nd that you want to further 
etter suit your needs. You 

 by adding additional anima-
s, and modifying the timing 

rties can be changed fr

 1. imation you want to modify.

 2. on.

 3.  button to change the default 

 4. Click the A ation button to add more 
animations to an object, including entrance effects, 
emphasis effects, exit effects, and motion paths.

 5. Click the arrow next to the Start: box and select when 
the animation will play—On Click, With Previous, or 
A er Previous.

 6. Enter a time in the Duration: box to control how fast or 
slow the animation plays. The higher the number, the 
slower the animation.

 7. Enter a time in the Delay: box to add a br efore the 
animation plays.

tips & tricks

 

 

tell me more
 

 

FIGURE PP 3.18

group to control when and 

how fast animations play.

Select an effect option t e 

the behavior of the animation
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chapter 4

 ❯ Delete, reorder, copy, and 

paste slides, and use the Office 

Clipboard

 ❯ Define a custom show and hide 

slides

 ❯ Add hyperlinks and comments

 ❯ Rehearse timings and use 

navigation tools

 ❯ Print presentations and handouts

Managing and 
Delivering Presentations

skills

In this chapter, you will learn the following skills:

introduction
 

 

Skill 4. 1 

Skill 4.2 

Skill 4.3 

Skill 4.4 

Skill 4.5 

Skill 4.6 

Skill 4.7 

Skill 4.8 

Skill 4.9 

Skill 4. 10 

Skill 4. 11 

Skill 4. 12 

Skill 4. 13 

Skill 4. 14 
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4.1 Deleting Slides from Presentations
tent for your presentation, 

view the slides. As you make 
hat a slide you created is not 

ermanently remove it. You 
tent by deleting it fr

To delete a slide:

 1. On the Slides tab, right-click the slide you want to delete.

 2. Click Delete Slide on the menu that appears.

FIGURE PP 4.1

tips & tricks

 1.  

 2.  

 3. 

try this

lect Delete Slide to remove 

the slide from the presentation.

t



   skill 4.2 Changing the Order of Slides  
   

4.2 Changing the Order of Slides

One of the most important aspects of a presentat

w of the information. It is important that your slides appear 

in a logi , grouped order for your audience to fully grasp the 

message you are trying to presen ter you have reviewed 

your presentation, you may find that you want to switch the 

order of some of your slides. You can change the slide order 

fr Slides tab in Norm iew or in Slide Sorter view.

To change the slide order from the Slides tab:

 1. Select the thumbnail of the slide you want to move.

 2. Click and drag until the gray line appears where you 

want the slide, and then release the mouse button.

The Slides tab in Norma

of your slides in a vertica

thumbnails of slides in a gr

seeing how your slides wor

slides around, experimenting

To change the slide order in Sl

 1. Select the th ail of t

 2. Click and drag unt he gr

wan ide, and then r

tips & tricks
 

tell me more

 

try this

 

 

IGURE PP 4.2

Slide Sorter View

ton to move R

w location.the slide t

thumbnail of the Select t

ant to move.

Release the mouse button to move

the ide to the new location.
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4.3 Copying and Pasting Slides
eating your presentation that 

t is similar to another slide’s 
ed to add. Instead of having to 

cond slide, you can copy the 
ntation where you want it to 
tent you need to change.

 1. y.

 2. On the Home tab, in the Clipboard group, click the Copy 
button.

 3. Click the slide that you want to appear before the new 
slide.

 4. Cl Paste button.

 5. The new slide has been added to the presentation.

tips & tricks

 

 

tell me more

 

try this

 ❯ 

 ❯   

 ❯ 

 ❯ 

 ❯   

 ❯ 

FIGURE PP 4.3

y Button

opied slide has been pasted 

as a new slide in the presentation.



   skill 4.4 Using the Office Clipboard  
   

4.4 Using the Office Clipboard
When you cut or copy items, they are placed on the Office 

Clipboard. A short description or thumbnail of the item rep-
resents each item in the ta w which item 
you are pasting into your presentation. T lipboard 
can store up to 24 items for use in rrent presentation or 
any othe pplication.

To te an item fr lipboard into a presentation:

 1. Select the item you w t to copy.

 2. On the Home tab, in the Clipboard group, click the Copy 
button.

 3. Place your cursor wher

 4. On the Home tab, in the 
Clipboard di og launche

 5. The Clipboard task pane a

 6. Click the item you wan

tips & tricks
 ❯ 

 ❯  

 ❯ 

tell me more

 

 

try this

FIGURE PP 4.4

em on the Clipboard to 

paste it into the presentation.

y Button

Clipboard Dialog Launcher
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4.5 Defining a Custom Show
custom slide show w that runs inside another 

ive you the ability to custom-
udie stead of creating 

rent audiences, you can add 
esentation and repurpose the 

nces.

 1. 

 2. p, click the Custom Slide 

stom Shows . . .

 3. ox, cl New . . . button.

 4. he De ustom Show dialog box, select the slides 
you want in your custom show.

 5. Cl Add button.

 6. Cl p  and down  arrows to reorder your 
slides.

 7. he Slide show name: box, type the name of the custom 
show.

 8. Click OK to add the custom show to your presentation.

 9. To close the Custom Shows dialog box, click the Close 
button.

tips & tricks
 ❯ 

 

 ❯  

tell me more

FIGURE PP 4.5 

o add

to the custom show.
Click the Add button.

e.

ab



   skill 4.6 Hiding Slides  
   

4.6 Hiding Slides
When you practice your presentation, you may find that you 
want to omit certain slides, but that you do not want to delete 
them from your presentation, in case you need them later. 
Hiding slides a ws you to prevent slides from being seen 
without permanently removing them.

To hide slides:

 1. Select the slide you want to hide.

 2. Click the Slide Show tab.

 3. he Set Up group, click t

When a slide is hidden, t
over the slide number in the 

To unhide the slide, click t

tips & tricks
 

 

try this

 

FIGURE PP 4.6

de

abHide Slide Button
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4.7 Adding Hyperlinks to Slides

hyperlink hat when clicked takes you 

yperlinks to navigate to Web 

tations, custom shows, or any 

n you point to a hyperlink, 

and, indicating at it is some-

creenTips. A ScreenTip is a 

n the mouse is placed over 

the link. Add a ScreenTip to include a more meaningful 

description of the hyperlink.

To add a hyperlink from one slide to another slide in the same 

presentation:

 1. Select the text or object you want as the link.

 2. Click the sert tab.

 3. he Links group, click the sert Hyperli  button.

 4.  box opens.

 5. n This Do nt.

 6. 

 7. T e the tex creenTip in the Text to display: box.

 8. Click OK to insert the hyperlink into your presentation.

FIGURE PP 4.8

tips & tricks

 

tell me more
 

try this

 ❯  

 ❯ 

FIGURE PP 4.7

Insert Tab

  on

Select Place in This Docu en .

Select slide to link to.
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4.8 Adding Comments
Comments are small messages you add to slides that are not 
meant to be a part of the presentation. Comments are useful 
when you are reviewing a presentation and want to add mes-
sages about changes or errors on a slide.

To insert a comment on a slide:

 1. Click the Review tab.

 2. he Comments group, click the New Co ent button.

 3. A balloon appears on the screen with the cursor ready for 
you to enter your comment.

 4. Type your comment.

 5. Click outside the comment to minimize it.

 6. To view the comment, cl
slide.

If you do not want you
pane, you can hide the comme
Review tab, in the Comments
button to hide the comments
Show Mar p button agai
Show Markup button togg
state when clicked. Whe
sentation, the Show Markup 
state. When comments are h
returns to its normal state.

tips & tricks tell me more

try this

FIGURE PP 4.9

Review Tab

n m zed omment
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4.9 Rehearsing Timings
r presentation. For exam-

t way through explaining the 
r presentation advance before 

r presentation, it is a good 
 say and set up iming for 
’s Rehearse Timings feature to 
tation with your slides.

iming feature:

 1. 

 2. Rehearse ings button.

 3. When t rst slide appears, begin rehearsing your 
presentation.

 4. Cl Pause button if you w t to stop the timer.

 5. Cl Next button to advance to the next slide.

 6. Continue rehearsing each slide, cl ng the Next button 
to advance the sl til you reach the end of the 
presentation.

 7. At the end of the presentat l be asked if you 
want to keep the timing as part of your slide show. Click 
Yes to include the timings as part of the presentation.

ming of your presentation, 
gs or not. If you want to use 

sed Timings check box 

in the Set Up group. If you do not w t to u imings, 
uncheck the box.

FIGURE PP 4.10

ide ow ab

Rehearse Timings Button 

FIGURE PP 4.11

Next Button

Rehearsal Timer

tips & tricks

 

tell me more

try this



   skill 4.10 Starting the Slide Show  
   

4.10 Starting the Slide Show
You can choose to start your presentation from the begin-
ning, playing it all the way through. But wha nd you 
don’t have as much time as you originally planned to present? 
Y ose to start the presentation from any slide in 
the presentation.

To start a presentation from t

 1. Click the Slide Show tab.

 2. he Start Slide Show gr
button.

To start a presentation from t

 1. Click the Slide Show tab.

 2. he Start Slide Show gr
Slide button.

Click the From Beginning button to start

presen a s
ide Show Tab

 e  s   presen a  

from the current slide

tips & tricks try this

 



    
 powerpoint 2010 chapter 4 Managing and Delivering Presentations 

4.11 Using Presentation Tools
w, you will need a way 

s you t k. You can use the 
utomatica a ide 

ant the freedom to depart 

from your scri l want to navigate the slide show 
yourself. This table lists commands for navigating a presenta-
tion in Slide Show view using the mouse and the keyboard:

COMMAND MOUSE COMMAND KEYBOARD COMMAND

owerPoint allow you to write 
iving your presentation. You 

Pen ine or circle important points 
Highlighter tool to add color 
asize parts of your slides.

ing the presentation tools:

 1. Pointer Options button.

 2. Select a pointer option Pen or Hi i ter.

 3. Click and drag the mouse to write on the slide or 
highlight part of the slide.

 4. Click the Po ter Options button and select Arrow to 
return to the arrow pointer.

FIGURE PP 4.13

Use the pen tool to mark 

slides as you would a page.

Select Arrow to e rn to 

the arrow point r.

Select a pointer option 

from the menu.

Pointer Options Button



   skill 4.11 Using Presentation Tools  
   

tips & tricks
 ❯ 

 ❯  

try this

 ❯ 

 ❯ 

 ❯ 

 from the perspective of . . . 
STUDENT
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4.12 Printing Presentations
tly in PowerPoint 2010. Pre-

elied on Print Preview for set-
rPoint 2010, the Print tab in 

l of the printing options 
t tab in Backstage view, you 

t the slides in color, grayscale, 
ust other elements of the 

oter.

tion:

 1. stage view.

 2. Click the Print tab.

 3. Verify that the correct printer name is displayed in the 
Printer section.

 4. Settings section, the last button displa
options for printing the presentation. By default, Color is 
selected. To change the print selection, cl tton, 
and then click an option: Color, Grayscale, or Pure 

Blac te.

 5. Click the Print button to print.

tips & tricks tell me more

try this

 

FIGURE PP 4.14

Print Button

Print Tab

Select a color option for 

printing from the menu.



   skill 4.13 Customizing Handout Masters  
   

4.13 Customizing Handout Masters
The Handout Master view a ws you to modify how the 
printed version of your presentat l look n you 
open the presentation in Handout Master view e a 
preview of the printed page with dotted placeholders for the 
slides, header, footer, page number, and date.

To open H t Master vie

 1. Click the ew tab.

 2. In the Master Views grou  

button.

You can show and hide placeholders in Handout Master 
view. When you hide a placeholder, it no longer appears in 
the Handout Master view. To show and hide a placeholder, 

on the Handout Master tab, i  
r’s check box.

Placeholders you can hide and show include

Header—appears in the upper-left corner of the page and 
displays the text you entered for the header in the Header 
and Footer dialog box.

Date—appears in the upper-right corner of the page and 
displays the date.

Footer—appears in the lo
displays the text you entere

Page Number—appears i
page and displays the curre
(not the slide number).

FIGURE PP 4.15

Master Butt
w Tab

FIGURE PP 4.16

ndout Master Tab Click a check box to hide and show 

placeholders on the printed handout.
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4.14 Previewing and Printing Handouts

owerPoin ives you the 

tline of the pre-

handout t of your presentation with 

er page and with areas for 

Notes Pages opti l print a copy of the 

here is one. Select Outline 

t outline of your presen-

tations, printing of handouts, 

ll done from the Print tab in 

To preview and print outlines, handouts, and notes:

 1. Click the File tab to open Backstage view.

 2. Click the Print tab.

 3. Verify that the correct printer name is displayed in the 

Printer section.

 4. he Settings section, the second button displays the 

page options for printing the presentation. By default, 

Full Page Slides is selected. To change int selection, 

click the button and then select an option.

 5. Click the Print button to print.

FIGURE PP 4.17

ab
int Button

Print Tab

Select a layout for the 

printed handouts here.

tips & tricks

 

tell me more

 

 

try this
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 chapter 5 
 Exploring Advanced 

Graphics, Tables, and Charts 

skills

In this chapter, you will learn the following skills:  

  introduction 
  

   

  Skill 5.1 

 Skill 5.2 

 Skill 5.3 

 Skill 5.4 

 Skill 5.5 

 Skill 5.6 

 Skill 5.7 

 Skill 5.8 

 Skill 5.9 

 Skill 5.10 

 Skill 5.11 

 Skill 5.12 

 Skill 5.13 

 Skill 5.14 

 Skill 5.15 

 Skill 5.16 

 Skill 5.17 

 Skill 5.18  

    ❯ Learn to modify pictures using the 

new picture effects available in 

PowerPoint 2010 

  ❯ Make a presentation file 

size smaller by changing the 

compression settings for images 

  ❯ Align text in tables and insert 

rows and columns 

  ❯ Modify charts including layouts, 

styles, and animating a chart 

  ❯ Create a multipart animation and 

adjust the animation timings 

  ❯ Add an action button to a slide 

  ❯ Record the slide show, including 

narration 

  ❯ Edit audio and video from within 

the PowerPoint application 

  ❯ Create a photo album of digital 

photographs  
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  umber of new commands 
raphics. These commands 

sing tools that in the past were 
iting applications. 

 n PowerPoint 2010 is the  
Artistic Effects he  Artist ects  command 

age. T rs mimic a wide 
g paint strokes, pencil strokes, 

lows. 

 To apply an artistic effect to a picture:

    1. Select the image you want to apply the artistic effect to.  

   2. Click the  Format  tab under  Picture Tools.   

   3. he  Adjust  group, click the  Artistic E s  button.  

   4. Select an option from the gallery to apply it to the 
picture.    

   5.1 Applying Artistic Effects to Pictures 

FIGURE PP 5.1

  

om 
the gallery to apply 
it to the picture.

      tips & tricks 
 

  

  tell me more 
  

    



   skill 5.2 es  
   

  One way to modify a picture is to remove the background 
from the picture. To remove the background from a picture, 
PowerPoint analyzes the picture and calculates which areas 
are the background. PowerPoin n marks the background 
areas for removal. The resulting effect is as if you had traced 
the main par re and then erased the background, 
leaving you with an outline of the picture. 

 To remove the background from a picture:

    1. Select the image you want to remove the background 
from.  

   2. Click the  Format  tab u    

   3. In the  Adjust  group, click t   
button.  

   4. The  Back ound Removal  

   5. Adjust the marked area un
w t it.  

   6. Click the  Keep Changes 
background from the ima    

  5.2 Removing the Background from Pictures 

emove Background Button mat TabFoPicture Tools 

FIGURE PP 5.2

ound Removal Tab

ep Changes Button

FIGURE PP 5.3

  tips & tricks 
  

   

  tell me more 
 

 

    ❯   

  

   ❯   

  

   ❯  

     

  try this 
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  esentation, you ma nd 
ay you w t. It may appear 

ppear slightly blurry. You can 
Picture Tools Format  tab. 

 

    1. dify.  

   2. Click the  Format  tab under  Picture Tools.   

   3. he  Adjust  group, click the  Corrections  button.  

   4. The ga ery displays how the selected imag  appear 
with the correction applied.  

   5. Select an option from the gallery to make the change.    

  5.3 Correcting Pictures 

Picture T t Tab

Select an option from the 
llery to make the change.

FIGURE PP 5.4

 e changing the following 

   ra re darker or lighter.  

   ge of color intensity within 
igh contrast will have bolder 
w contrast  have more 

  

  Softness —removes hard edges, giving the picture a 
smoother feel.  

  Sharpness —removes any blurriness, giving the picture a 
crisper feel.    

  tips & tricks 
  

 

  

 

   

  tell me more 
 

    



   skill 5.4 Changing the Color of Pictures  
   

  her graph ct you can apply to a picture in Power-
Point is to recolor mage. When you color an image, 
PowerPoint t es the image and applies a color overlay
colors are removed from the image and replaced with shades 
of one color. The resultin ct is as if you were lo ng at 
the image through colored glass. 

 To recolor a picture:

    1. Select the image you wan  

   2. Click the  Format  tab u    

   3. he  Adjust  group, click t     

   4. The gallery displays how t
with the color applied.  

   5. Select an option from t     

  5.4 Changing the Color of Pictures 

   

Select an option from the 
gallery to make the change.

FIGURE PP 5.5

    ❯ 

 

  

   ❯  

      

    tips & tricks 
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  esentation, you may only want 
ld edit the picture in an 

ld use the  Crop  tool in 

 

    1. rop.  

   2.  r  Picture Tools.   

   3.  Crop  button.  

   4. ines around the edges of the 
andles.  

   5. Point to a cropping ha n the cursor changes to 
one of the crop cursors, click and drag toward the center 
of the image.  

   6. Press E to accept the changes.    

 Notice the size of the objects in the image does not change. 
When you  crop  an image, it is as if you are removing part of 
the image, hiding it from sight. 

  5.5 Cropping Graphics 

orma

Cropping Handel

Cr ton

FIGURE PP 5.6

  tips & tricks 
 

 

  

  tell me more 
   

    ❯  

  

   ❯  

  

   ❯  

  

   ❯  

       



   skill 5.6 Compressing Pictures  
   

  The more images you add to a presentation, the larger the 
presentation’ l become. Before sending a presen-
tation out to others, it is a good practice to reduce t
size as much as possible. When you compress the pictures in a 
presentation, you can choose the target output for the presen-
tation:  Print (220 ppi),   Screen (150 ppi),  or  E-mail (96 ppi).  
 PPI  stands for pixels per inch. The higher the PPI, the less the 
imag e compressed. The lower the PPI, the mor
imag e compressed, resulting in a smalle t 
potentially lesser qu ity images. One way to reduce the file 
size of a presentation is to change the target output for all the 
images in the presentation. 

 To change the default ta
presentation:

    1. Click the  File  tab to open  

   2. Click the  Options  button.  

   3. he  PowerPoint Options 
 Advanced  button.  

   4. he  Image Siz  
compress ages in e  

   5. Click the  Set defa  
ion.  

   6. Click  OK  in the  PowerP        

  5.6 Compressing Pictures 

V ompress images 
in file option is not checked.

option.

Advanced Button

FIGURE PP 5.7

 

 

    1.   

   2.     

   3.     

   4.    

   5.    

   6.         

  try this 
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  es to an image and decide to 
ld u Undo  com-

s original state, or you could 
Reset Picture he  Reset Picture  command 

tting applied to the picture, 
tate it was before any format-

 To reset a picture:

    1. Click the  Format  tab under  Picture Tools.   

   2. he  Adjust  group, click the  Reset P   button.  

   3. Any PowerPoint formatting you added to the picture is 
removed.    

  5.7 Resetting Pictures 

Reset Pi e Butt Picture Tools Format Tab

 FIGURE PP 5.8 

  tips & tricks 
  

    

  try this 
 

 

     



   skill 5.8 Aligning Text in Tables  
   

Horizontal ignment refers to how text is aligned with regard 
to the left and right margins of a cell.  Le   alignmen igns 
the text on the left side, leaving the right side ragged.  Center
alignment centers each line of text relative to the cell margins. 
Right alignment aligns the text on the right side, leaving the 
left side ragged. 

 To change the horizontal alignment of text in a cell:

    1. Click in the cell you want to change.  

   2. Click the  Layout  tab unde    

   3. In the  A ment  group, cl
alignment buttons:

  Align   Text Left  
    

     Center  
  

  

     Align Te ght  
  

       

  5.8 Aligning Text in Tables 

bl T 
Click one of the horizontal 

Horizontal alignment 
as been changed.

FIGURE PP 5.9

 Vertical alignment refers to how text igned with regard 
to the top and bottom of a cell.  Top ignment places the text 
at the top of the cell.  Middle ignment places the text in the 

middle of the cell.  Bottom  al
bottom of the cell. 
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Click one of the vertical 

Vertical alignment
has been changed.

FIGURE PP 5.10

    tell me more 
 

 

     

  

        

  

  

        

  

  

    

     

  try this 
 

  

  

 

 

 

 ❯                

   ❯             

   ❯                  

 t of text i :

    1. ange.  

   2.  Table Tools.   

   3. he  Alignment  group, click one of the vertical 
ignment buttons:

      ign   Top      

     Center Vertically      

     ign Bottom  
  

         



   skill 5.9 Inserting and Deleting Rows and Columns in Tables  
   

  Once you have created a table, you often find you need more 
rows or columns. You can easily insert additional rows and 
columns from the  Table Tools  contextual tabs. 

 When you place the cursor in a table, the  Table Tools  con-
textual tabs display. These tabs ar led contextu  tabs 
because they only display when a table is the active element. 
The  Design  tab contains tools to change the look of the table, 
such as shading and borders. The  Layout  tab contains tools to 
change how information is displayed in the table, such as row 
and column commands. 

 To insert an additional ro

    1. Cl Layout  tab unde    

   2. To insert a new row, click t  
 Insert Below  button.  

   3. To insert a new column, cl  
the  sert ght  button.    

 To delete a row or column:

    1. Click in the row or colum  

   2. Click the  Layout  tab unde    

   3. Click the  Delete  bu    

  5.9 Inserting and Deleting Rows and Columns
in Tables 

e rt Row B owIn y  ab

o the Left

o the Right

FIGURE PP 5.11

  tips & tricks 
 

  

  

  tell me more 
 

 

 

  

  

  try this 
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  rPoint displays the  Chart Tools
ide easy access to all the chart 

 tools. From the  Design  tab, 
t or style using the predefined 

Quick Layouts Quick Styles.  Quick Layouts apply com-
ta tables, while Quick Styles 
ine st ls, and shape 
esentation theme. 

 art can make a dramatic 

 To change the chart layout using a Quick Layout:

    1. Click the  Design  tab under  Chart Tools.   

   2. he  Chart Layouts  group, click one of the chart 

layouts, or click the  More  button    to see all the chart 
layouts available.    

 To change the chart style using a Quick Style:

    1. Click the  Design  tab under  Chart Tools.   

   2. he  Chart Styles  group, click the style you want to use, 

or click the  More  button      to see all the chart styles 
ava

  5.10 Modifying Charts 

youts.
tyles.

   

     
  tell me more 

FIGURE PP 5.12



   skill 5.11 Animating Charts  
   

  When you add a chart to a slide, by default it appears as a 
static object. One way to help your information come to life 
for your audience is to animate the chart. Depending on the 
animation scheme you have chosen, you can animate the 
chart as one object or you can apply the animation scheme to 
individual parts of the chart. 

To animate a chart:

    1. Select the chart you want  

   2. Click the  Animations  tab.  

   3. he  Animation  group, cl  
select an animation sche  

   4. Click the  E s Option   
have imation applie    

  5.11 Animating Charts 

Select an animation scheme.

FIGURE PP 5.13

      tips & tricks 
 

   

 

 

  

  tell me more 
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 ntation can help your slides 
or example, you can design 

een when you click the slide. 
milar exit effect to the same 

ultiple animations to a 

 ect:

    1. ant to add additional 

   2. Click the  Animations  tab.  

   3. he  Advanced Animations  group, click the  Add 

A ations  button.  

   4. Select an option from ga ery.    

 When you add animations to a slide, PowerPoint displays a 
number next to each animated object. These numbers indi-
cate the order in which the objects will be animated. 

  5.12 Creating Multipart Animations  

Anima ab

from the gallery.

tion buttonClick the Add

 FIGURE PP 5.14 

 

    

  tips & tricks 



   skill 5.13 imings  
   

  When you apply an animation to an object in PowerPoint, 
the animation is set to play immediately and for a default 
length of time. But what if you want a pause before the ani-
mation plays? Or have the animation play more qu
slowly than the default length of time? You can control both 
when and for how long an animation plays. 

 To control animation timings:

    1. Select the animated obje  

   2. Click the  A ations  tab.  

   3. he  Timing  group, ente
animation to play in the  A     

   4. he  Animation Delay:  b
seconds to wait before t    

  5.13 Setting Animation Timings 

Duration controls how long 
.

y controls when 
the animation starts.

FIGURE PP 5.15

      tips & tricks 
  

    

  tell me more 
 

  

  try this 
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  action button ide that performs 
 are used in  Slide Show  view. 

avigate between slides or to 

 

    1.  awing  group, click the 
    

   2. Action Buttons  section. 
allery.  

   3. ant the action button to 

   4. The  Action Settings  di og box opens.  

   5. Click the  Hyperlink to:  arrow, and select where you want 
the button to navigate to when clicked.  

   6. Click  OK.     

 Each action button option in Shapes  gallery is designed 
for a specific purpose. There are buttons that are used to 
navigate within a presentation (such as the  Next,   Previous,
and  Home  buttons), and there are buttons which are used to 
access additional content (such a Information,   Movie,
Document,  and  Sound  buttons). 

  5.14 Creating an Action Button 

Select a slide to link to.

Click OK.

Action Butto

FIGURE PP 5.16

  tips & tricks 
  

 

  

  tell me more 
 

  

  try this 
  

  

     



   skill 5.15 Recording a Slide Show  
   

  Rather than presenting a slide show live, you can choose 
to record your slide show, including the timings and narra-
tions. When you play the recorded slide show, PowerPoint 
will automatica y the recorded narrat avigate 
through the slides using the timings you created when you 
recorded the slide show. 

Note:  order to record your narrat l need to have 
a microphone or headset with a microphone attached to your 
computer. Please be sure the microphone/headset is plugged 
in and wor ng before doing the following steps. 

 To record a slide show:

    1. Click the  Slide Show  tab.  

   2. he  Set Up  group, click the  Record Slide Show  
button.  

   3. The  Record Slide Show  di   

   4. Verify the  Slide and anima  
N ations and laser point   

   5. Click the  Start Recordin     

   6. When t rst slide app
Work through your presen
presenting to an audience.  

   7. Click the  Pause  bu   

   8. Click the  Ne   bu  

   9. Continue narrating each sl   
to advance the slides, unt
presentation.    

  5.15 Recording a Slide Show 

or 
recording .

Slide Show Tab cord Slide S w Button

FIGURE PP 5.17

     When you record a presentation, PowerPoin
timings and narration you recorded as the default playback 
options for the presentation. To change these options, on 
the  Slide Show  tab, in the  Set Up  group, click the  Set Up 

Slide Show  button. In the  Set Up Show  dialog box, click 

the  Manually  radio button i  
advance the slides you  
the  Show without narration 
tion without the narration. 

    ❯   

    

   ❯  

        

  tips & tricks 
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  a nd that you need 
int or end at lier point. 

eded an audio editing 
oints udi  Power-
hin PowerPoint by using the 

udio Tools  tab. 

 

    1. he slide with audio you want 
 

   2.  r  Audio Tools.   

   3.   .  

   4. The  Trim Audio  dialog box appears. The dialog includes 
a visual representation of the audio file along a timeline.  

   5. On the left side of the timeline is the green  Start Time  
indicator. Click and drag the indicator to the right to 
have the audio begin at a later point.  

   6. On the right side of the timeline is the red  End Time  
indicator. Click and drag the indicator to the left to have 
the audio stop playing at an earlier point.  

   7. Click the  Play  button to play the trimmed audio piece.  

   8. Click  OK  to accept the changes and trim the audio.    

  5.16 Editing Audio on a Slide 

Audio Tools Pla Tab   

 FIGURE PP 5.18 

Start Time Indicator End Time Indica or

FIGURE PP 5.19



   skill 5.16 Editing Audio on a Slide  
   

 from the perspective of . . . 
 MIDDLE SCHOOL PRINCIPAL 

    tips & tricks 
 

   

  

  tell me more 
 

  

  

 

  

  try this 
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  tart times of audio clips 
dify when a video begins 

hin PowerPoint by using the 
 Video Tools  tab. 

 

    1. dit.  

   2.  r  Video Tools.   

   3.   .  

   4.  ppears. The dialog includes 
e a timeline for the video.  

   5. On the left side of the timeline is the green  Start Time  
indicator. Click and drag the indicator to the right to 
have the video begin at a later point.  

   6. On the right side of the timeline is the red  End Time  
indicator. Click and drag the indicator to the left to have 
the video stop playing at an earlier point.  

   7. Cl Play  button to play the trimmed video piece.  

   8. Click  OK  to accept the changes and trim the video.    

  5.17 Editing Video on a Slide 

FIGURE PP 5.20

      tips & tricks 
    ❯  

  

   ❯  

    

  tell me more 
  

  

  

  

  try this 
 

 

     



   skill 5.18 Creating a Photo Album  
   

  Have you ever wanted to create a PowerPoint presentation 
of pictures you downloaded from your digital camera or cell 
phone? PowerPoint’s  Photo Album  feature does just that. 
From the  Photo Album  di og box, mport your digi-
tal photographs and add captions and effects to each image. 
The  Photo Album  feature then creates a new presentation 
based on the information you entered, a wing you to fur-
ther modify the presentation using the robust formatting 
tools ava n PowerPoint 2010. 

 To create a photo album:

    1. On the  Insert  tab, in the  Images  group, cl Photo 

A   button.  

   2. The  Photo Album  di og b   

   3. Click the  File/Disk  bu   

   4. he  Insert New Pictures 
you want to include in t
Insert  button.  

   5. Continue adding pictur  

   6. Cl New Te x 
between images in t  

   7. Click the  Create  bu
new presentation.    

  5.18 Creating a Photo Album 

Insert Tab

o Album Button

ct New Photo Album. . .

FIGURE PP 5.21

Click the File/Disk button
to add pictures.

w Text Box 
button to add a text slide.

Click the C eate button to 
eate the photo album.

FIGURE PP 5.22

  tips & tricks 
   

    

  tell me more 
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   projects Data fi les for projects can be found on 
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   3.           

   4.   
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   2.   

   3.           

   4.   

   5. 

         

 

   6.              
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 chapter 6 
 Polishing and Finishing 

the Presentation 

skills

In this chapter, you will learn the following skills:  

  introduction 
  

 

    

  Skill 6.1 

 Skill 6.2 

 Skill 6.3 

 Skill 6.4 

 Skill 6.5 

 Skill 6.6 

 Skill 6.7 

 Skill 6.8 

 Skill 6.9 

 Skill 6.10 

 Skill 6.11 

 Skill 6.12 

 Skill 6.13 

 Skill 6.14 

 Skill 6.15 

 Skill 6.16 

 Skill 6.17 

 Skill 6.18  

    ❯ Add slides from another 

presentation 

  ❯ Format text and slides including 

aligning text, applying character 

effects, and changing line spacing 

  ❯ Use the Format Painter to copy 

and paste text formatting 

  ❯ Use the Animation Painter to copy 

and paste animation settings 

  ❯ Modify the slide master 

  ❯ Save slides and presentations 

in a variety of ways, including as 

video, PDF, a graphic, template, 

and compatible file 

  ❯ Package a presentation for a CD 

  ❯ Broadcast a presentation 

  ❯ Publish slides to a Slide Library  
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  a d information, such as a 

evenue projections, you may 

n more than one presentation. 

ide, including addin he 

ide from the origin  presen-

. You can add slides from one 

he  Reuse Slides  task pane. 

 ntation:

    1.    group, click the  New 

 ct  Reuse Slides.  . .  

   2. The  Reuse Slides  task pane appears.  

   3. Click the  Browse  button and select  Browse File.  . .  

   4. he  Browse  dialog box, navigate to the presentation 

you want to reuse slides from and select the file.  

   5. Click the  Open  button.  

   6. A list of slides appears.  

   7. Click the slide you want to add to the presentation.    

   6.1 Adding Slides from Another Presentation 

FIGURE PP 6.1

  ton Arrow

lect Reuse Slides. . .

ane

Browse Button

   

      
  try this 



   skill 6.2 Applying Character Effects  
   

  When you add text to a slide, it is formatted according to 
the slide design. But what if you wan t to look differ-
ent from the preset design? You can call attention to text in 
your presentation by using the bold, italic, underline, strike-
through, or shado cts. Remember, these effects are used 
to emphasize important text, and should be used sparingly. 

 To add character cts to your text, on the  Home  tab, in the 
Font  group:

      Bold —click the  Bold  button 
  

.  

  It ic —click the  It ic  button 
  

.  

  Underl e —click the  Un   
  

  Shadow —click the  Sha     

     Str rough —click the      
 When text has the bold, it
through effect applie
bon. To remove t ct, cl
press the appropriate keyboar

  6.2 Applying Character Effects 

alic

Bold

Sh ow Text

rline
ethrough

Text with formatting applied.

FIGURE PP 6.2

   Character spacing refers to the amount of horizontal space 
that appears between characters when you typ  some 
ca l want to m e the characters closer together to 
fit better on-screen. In other ca  want to m e the 

characters farther apart for a vi
ing of the characters in text, in  
acter Spacing  button 

  

    

        

 

                  

                    

                      

 

    1.   

   2.          

  tips & tricks 

  try this 
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  t is lined up with regard to        To change the alignment of text:

    1. Click in the text you want to change.  

   2. On the  Home  tab, in the  Para aph  group, click an 
ignment button.

      ign   Te eft  
  

  

  Center      

     ign Te ght      

     Justify  
  

       

  6.3 Aligning Text 

FIGURE PP 6.3

ter Justify

e t e t

 t igne  regard to 
r.  Top  alignment places 

r.  Middle ignment cen-
r.  Bottom  ignment 

he placeholder. 

 To change the vertical ignment of text:

    1. Click in the text you want to change.  

   2. On the  Home  tab, in the  Para aph  group, click the 
ign Text  button and select an option:  Top,   M   

or  Bottom.     

To
Middle

Bott

Align Text Button

FIGURE PP 6.4

  tips & tricks 
 

  

  tell me more 
   

 

  

  try this 
  

                    

                 

                    

                   

 

    

         , 

  

      centers each line 

.   

, 

leaving the left side ragged.

     

  



   skill 6.4 Adding Columns to Text Placeholders  
   

  When you add a list to a slide, the items in the list are dis-
played in a single column. This is fine if you have a few items 
in the list, but what if your list includes more items than will 
ea n a single vert n? You can apply columns to 
text, giving you t ity of displaying lists across a slide. 

 To apply columns to text:

    1. Select the text placeholder containing the list you want 
to convert.  

   2. On the  Home  tab, in the  P  
Col   button and sele   
Two Col s,  or       

 After you have applied t
you can resize the tex
to even out the number of ite

  6.4 Adding Columns to Text Placeholders 

FIGURE PP 6.5

on

o text.

      tips & tricks 
  

 

 

   

   

  tell me more 
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Line spacing etween lines of text. The 
t PowerPoint 2010 is single 

ood choice to use for the items 
sed spacing options include 

. When you increase the line 
ite space betwee ms 

 To change line spacing:

    1. Select the text you want to change.  

   2. On the  Home  tab, in the  Para aph  group, click the 
arrow next to the  Line Spacing  button.  

   3. Select the number of the spacing you want.    

  6.5 Changing Line Spacing 

  tips & tricks 
 

 

    1.       

     

   2.    

  

     

  try this 
  

    1.       

    

   2.    

           

FIGURE PP 6.6



   skill 6.6 Using the Format Painter  
   

  PowerPoint 2010 gives you t ity to apply complex for-
matting to objects. If you want to use the same formatting for 
more than one object, you could select the second object and 
reapply all the effects to create the fin esult, or you could 
use  Format Painter  to copy the formatting from one object 
to another. 

 To use Format Painter:

    1. Select the object that has the formatting you want to 
copy.  

   2. On the  Home  tab, in the   
Format Painter  button   

   3. Click the object tha  

   4. The formats are automati
object.    

 If you want to apply the forma
the  Format Painter  bu
until you click the  Format Pa   
to deselect it. 

  6.6 Using the Format Painter 

 

Format P ter Cursor

FIGURE PP 6.7

      tips & tricks 
 

  

  try this 
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  er of character formats and 
ant to return your text to 

erform m iple  Undo  com-
Clear All Formatting

tting and removes any 
d to text, including character 

ves only plai . 

 To remove formatting from text:

    1. Select the text you want to remove the formatting from.  

   2. On the  Home  tab, in the  Font  group, click the  C l 

Formatting  button.    

  6.7 Clearing Formatting 

FIGURE PP 6.8

The Clear All F tting command 
removes formatting from text.

 

 

    

  tips & tricks 



   skill 6.8 Using Animation Painter  
   

  imations can become complex very qu . You can invest 
a lot of time wor ng imation to get it just right. What 
if you want to use those same animat cts on another 
slide? In past versions of PowerPoint, you would need to re-
create the animation. PowerPoint 2010 includes a new feature 

led the  Animation Painter.  T imation Painter works 
similarly to the Format Painter, but instead of copying and 
pasting formatting, the Animation Painter copies and pastes 
the animations that have been applied to an object. 

 To use t imation Painter to copy and paste animations:

    1. Sele e at has the animation you want to 
copy.  

   2. Click the  Animations  tab.  

   3. he  Advanced Animati  
Pa ter  button.  

   4. Click the object tha  

   5. The animation is automati
object.    

 If you want to apply the anim
click the  Animation Painter  
stay on until you click the  An  
or press   q to deselect it. 
  

  6.8 Using Animation Painter 

FIGURE PP 6.9

P

imation Painter Cursor

     

    
    tips & tricks 



    
 powerpoint 2010 chapter 6 Polishing and Finishing the Presentation    

  ok of elements in a presenta-
as one slide master contain-

t what if you want to adjust 
r needs?  Slide Master 

aster’s layouts. You can resize 
l as change other formatting, 

. 

 ick the first slide thumbna
 he PowerPoint window. 

youts, click one of the 
ter thumbnail. You will notice 

a dotted line connecting the slide master thumbnail with its 
associated layout thumbna . 

 To change the theme of a slide master:

    1. Click the  View  tab.  

   2. he  Master Views  group, click the  Slide Master  
button.  

   3. On the  Slide Master  tab, in the  Edit Theme  group, 
click the  Themes  button and select an option from the 
gallery. Every layout under the slide master ha w 
theme applied to it.    

  6.9 Modifying the Slide Master 

ter

FIGURE PP 6.10

 t:

    1. yout from the  Slides  pane 
 

   2. he placeholder by 
he resize h les   .  

   3. To move a placeholder, select the placeholder. When 
the cursor changes to the move cursor 

  
, click and 

drag the placeholder to the new location and release the 
mouse button.    



   skill 6.9 Modifying the Slide Master  
   

     To change the bullet style for a layout:

    1. ide Master view, select a layout from the  Slides  pane 
on the left.  

   2. Select the placeholder containing the bu s you want to 
change.  

   3. Click the  Home  tab .   

   4. In the  Para aph  group, cl  
select an option from t     

FIGURE PP 6.11

Click and dr esize handle 
to resize the placeholder.

Select an tion 
from the gallery.

FIGURE PP 6.12
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    tips & tricks 
 

 

  

  tell me more 
 

  

  from the perspective of . . . 
 MARKETING DIRECTOR 

 

 



   skill 6.10 Adding New Layouts and Placeholders to the Slide Master  
   

  The slide master for a presentation comes with a number of 
prebuilt layouts for you to use. In addition to using these stan-
dard layouts, you can add your own layouts and then format 
and add placeholders to the layouts. 

 To add a new layout to the sl

    1. On the  Slide Master  tab, i  
the  Insert Layout  button.  

   2. A new layout is added u    

    6.10  Adding New Layouts and Placeholders to the
Slide Master 

FIGURE PP 6.13

ay on

     The default placeholders in slide layouts are content place-
holders. Content placeholders include buttons for adding a 
wide variety of content types including tables, charts, pictures, 
clips, and Smart t. But what if you want to include a layout 

that only allows one typ
placeholder? Y
any layout. PowerPoint i
types for you to add to layouts
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  tips & tricks 
 

 

  

  

  

  tell me more 
 

      

FIGURE PP 6.14

Placeholder inserted 
on layout

 aster:

    1. he placeholder to.  

   2.  he  Edit Master  group, click 
 row and select an 

   3. The cursor changes to the crosshair cursor   .  

   4. Click on the slide layout where you w t the placeholder 
to appear.    



   skill 6.11 evious Versions of PowerPoint  
   

  Some features in PowerPoint 2010 are not ava n previ-
ous versions of the application. If a presentation uses one of 
the new features, opening it in a previous version of Power-
Point may have unintended consequences. For example, if 
you apply Quick Styles to images in a presentation, the styles 
will be converted to a static image in PowerPoint 2003. If you 
are sharing a presentation created in PowerPoint 2010 with 
someone who may be using an earlier version of PowerPoint, 
you should check the presentation for compat ity issues. 

 To check your presentation to see if it contains elements 
that are not compatible with earlier versions of Microsoft 
PowerPoint:

    1. Cl File  tab.  

   2. The  Info  tab in Backstag  
Click the  Check for Is  
Check Compatib ity.   

   3. The  Compatibility Checke  
Compatibility Checker lis
presentation that may b
the presentation in an earl
format. For each item, t
times the issue occurs in t

   4. Review the compat it   
close the Compatibility C    

  6.11  Checking for Compatibility with Previous Versions
of PowerPoint 

FIGURE PP 6.15

ab

fo Tab r issues button.

Select Check Compatibility.

Note:  Running the  Compatibility Checker  does not change 
your presentation. It only list ms that will lose func-
tionality when the presentation is saved in an earlier Microsoft 

PowerPoint format. It is u
m e any changes to the prese  
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FIGURE PP 6.16

Click here to check for 
compatibility when saving in 
PowerPoint 97-2003 formats.

  tips & tricks 
 

 

 

   

  tell me more 
 

    



   skill 6.12 Saving Slides as Graphics  
   

  You ma nd that you want to include a picture of a slide in 
another document, such as a marketing plan created in Word. 
In PowerPoint, you can save an individual slide as a picture 
and then insert that image into a Word document. 

 To save a slide as a graphic:

    1. Click the  e  tab.  

   2. Click  Save As.   

   3. he  Save As  dialog box    
and select a graphic forma
file formats).  

   4. Click  Save.   

   5. PowerPoint displays a mes
save all the slides in the pr
slide. Click the  C nt Sl  
slide as a graphic.    

  6.12 Saving Slides as Graphics 

Click Save As.ab

FIGURE PP 6.17

     There are a number of graphic file formats for you to choose 
from:       
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 FIGURE PP 6.18 

Select the graphic format you
wa  to save the slide as.

ick Save.

  tips & tricks 
 

  

 

  

  tell me more 
 

 

 

    



   skill 6.13 Saving a Presentation as a PDF  
   

  One way to publish a presentation in a static format is to 
save the presentation as a PDF file.  PDF  stands for  portable 
document le,  which is Adobe’s custom format for displaying 
forms and documents in a Web browser. When you sav
in PDF format, the slides are converted into static pages with 
each slide on a separate page. All the formatting you applied 
to the presentation (including fonts, images, and styles) is 
preserved, but transitions and animations are not part of the 
PDF DF e read by any computer with Ado-
be’s Acrobat Reader insta d, but they cannot be changed by 
those reading t

 To save a presentation as a PDF:

    1. Click the  e  tab.  

   2. Click  Save & Send.   

   3. Under  File Types,  click the  
Doc ent  button.  

   4. Under  Create a PDF/XPS  
PDF/XPS  button.  

   5. he  Publish as PD  
where you want to save t  

   6. Click in the  File name:  bo  

   7. Click the  Publish  button.  

   8. PowerPoint saves t    

 An  XPS (XML Paper Specification) 
that creates a static documen
readable but not easily edit
Microsoft’s XPS Viewer, wh
dows Vista and Windows 7. 

  6.13 Saving a Presentation as a PDF 

Sa  & Send Tab

eate
PDF/XPS Document.

eate PDF/XPS Button

FIGURE PP 6.19

      tips & tricks 
 

    1.  

   

   2.    

   3. 

     

  tell me more 
 

 

    1. 

 

   2.    

   3.     

   4.  

        



    
 powerpoint 2010 chapter 6 Polishing and Finishing the Presentation

 template h pre ned settings that you 
r own. Power-

ilt-in templates that you can 
reate your own tem-

reate other presentations. 

 te a new blank presentation. 
w layouts and editing exist-

l add to the template. Add 
tent sl ave in 

reate a title slide, a text with 
tArt slide, a video slide, and so 

ide—do not add content 
esentation including 

applying a theme, creating a background for the slides, for-
matting text, and adding slide transitions. Once you have cre-
ated the templa l need to save it for future use. 

 To save a template:

    1. Click the  File  tab.  

   2. Click  Save As.   

   3. Cl Save as type:  arrow and select  PowerPoint 

Template (  *  .potx).   

   4. The  Save As  di og box automatically navigates to the 
Templates  location.  

   5. Click in the  File name:  box and type a file name.  

   6. Click the  Save  button.    

  6.14 Saving a Presentation as a Template 

FIGURE PP 6.20

avigates x The Save As dialog b
n.tioto the Templates loca

Type a file name.

Sav ton

Select PowerPoint Template.



   skill 6.14 Saving a Presentation as a Template  
   

The template you saved now appears 
in the New Presentation dialog box.

FIGURE PP 6.21

 

    

      tips & tricks 

 To create a new presentation from a presentation template 
you created:

    1. Click the  File  tab.  

   2. Click  New.   

   3. Under  Available Template   

templates  button.  

   4. The template you save
Presentation  dialog box.  

   5. Click the template to sele      
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  Package for CD ture allows you to copy your 
om inside PowerPoint. The 

y default, allowing you to run 
puter. 

 To use the Package for CD feature:

    1. Place a blank CD-R or CD-RW in your computer’s CD 
drive.  

   2. Click the  File  tab.  

   3. Click  Save & Send.   

   4. Under  File Types,  click  Package Presentation for CD.   

   5. Under  Package Presentation for CD,  click the  Package 

for CD  button .   

   6. The  Package for CD  dialog box opens.  

   7. Type the name of the CD in the  Name the CD:  box.  

   8. Click the  Copy to CD  button.    

  6.15 Packaging a Presentation for CD 

Sa  & Send Ta ackage Presentation for CD.

ckage for CD Button

FIGURE PP 6.22



   skill 6.15 Packaging a Presentation for CD  
   

     Y ge your presentation to a folder. You 
can then send the presentation via e-mail or a removable 
storage medium, such as a US sh drive. When sending 
a presentation through e-mail, be aware that the larger the 

packaged presentation is, t
ent to download the present
the PowerPoint viewe
necessary. 

  tips & tricks 
    ❯  

  

   ❯   

  

    

  tell me more 
 

    

Click the Copy to CD button.

Type the name 

FIGURE PP 6.23
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 he ability to  broadcast

ternet. When you broadcast a 
ink to a spe . Your 

owser and navigate to the 
he presentation live as you 

 

    1.     

   2.  p, click the  Broadcast Slide 

    

   3. The  Broadcast Slide Show  dialog box opens.  

   4. Click the  Start Broadcast  button.  

   5. Log in to the broadcast service.  

   6. PowerPoint creates a U hers to view the 
broadcast. Copy the link and send it to whomever you 
want to watch the broadcast. Be sure to let your audience 

ow the date and time when l be showing the 
presentation.  

   7. Cl Start Slide Show  button to begin the 
presentation and broadcast it live.    

  6.16 Broadcasting a Presentation  

 T

FIGURE PP 6.24

roadcast t PowerPoi
ed.ecSer

Click Start Br ast to begin 
presentation and broadcast it live.

 FIGURE PP 6.25 



   skill 6.16 Broadcasting a Presentation  
   

     tips & tricks 
 

  

 

    

  

  tell me more 
 

 

 

  

  try this 
  

    1.    

   2.    

   3.     

   4.  
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   with others is through a  Slide 

Library  ted on a server and contains 
hers to view and use in 

ibraries for creating presen-
tation designs are consistent 
nizations. 

 y:

    1.     

   2.    

   3. Under  Save & Send,  click  Publish Slides.   

   4. Under  Publish Slides,  click the  Publish Slides  button.  

   5. he  Publish Slides  dialog box, click the check boxes 
next to the slides you want to publish.  

   6. Enter the location of the Slide Library in the  Publish To:  
box.  

   7. Click  Publish.     

  6.17 Publishing Slides to a Slide Library 

FIGURE PP 6.26

Sav ab

s.

Publish Slides Button

FIGURE PP 6.27

Click the chec bo
next to the slides you
want to publish.

Enter the location of 
the Slide Library in 
the Publish To: 

Click Publish.



   skill 6.17 Publishing Slides to a Slide Libr
   

 To add a slide from a Slide Library to a presentation:

    1. On the  Home  tab, in the  Slides  group, click the  New 

Slide  button and select  Reuse Slides.  . .  

   2. The  Reuse Slides  task pane appears.  

   3. he  Insert s om:  bo
Librar ick the arro   

   4. A list of slides appears.  

   5. Click the slide you w t     

  tips & tricks 
 

  

  tell me more 
 

 

  

  try this 
  

     

FIGURE PP 6.28

Click a slide to add it 
to the presentation.

Select Reuse Slides. . .
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  oint 2010 is t ity to save 

 a presentation as a video gives 

matted, self-running slide 

ideo will i l the tran-

e added, as well as timings and 

ed. By saving the presentation 

esentation through e-mail, 

. 

 o:

    1. ing narration. For more 

d a slide show, see t l 

   Chapter 5.  

   2.     

    3. Click  Save & Send.   

    4. Under  File Types,  click  Create a Video.   

    5. Under  Create a Video,  click the  Computer & HD 

Displays  button and select a display option.  

    6. Click the  Create Video  button.  

    7. The  Save As  dialog box opens with  Windows Media 
Video (  *  .wmv)  selected as the file type.  

    8. Naviga cation where you want to save the 

video.  

    9. In the  File name:  box, enter a name for the video.  

   10. Click  Save.     

  6.18 Saving a Presentation as a Video 

le Tab

Select Create a Video.

te Video Button

Sav ab

FIGURE PP 6.29

 ntly video playback capabil-

ys are able to play videos at a 

esentation is to be played 

, you will want to 

save it at the medium setting. Video presentations can also 

be played on mobile devices, but you should set the display 

option to the lowest setting. Be aware that at this size, some 

text in your presentation may not be legible. 

  tips & tricks 
 

  

   

  tell me more 
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Data fi les for projects can be found on 
www.mhhe.com/offi  ce2010skills
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glossary

a
Action button: A button you add to a slide that performs a set 
function.

Animation: Movement of an object or text in a presentation. The 
four basic animation schemes are En ance, Emphasis, Exit, and 
Motion Paths. 

Animation Painter: To at copies and past imation from 
one object to another.

Artistic E s: Application of d rent graphic filte
image. T rs mimic a wide variety of artistic tools, including 
paint strokes, pencil strokes, watercolors, mosaics, blurs, and glows.

b
Bac The graphic element that fills a slide. Backgrounds 
can be solid colors, textures, or images.

Brightness: Control of how dark or light a picture appears.

Broadcast: Method for delivering presentations via the Internet. 

B ed list: List type used to organize information that does not 
have to be displayed in a particular order.

c
Cell: The intersection of a row and column in a table. 

Character e ects: Effects applied to text to alter its appearance. 
cts include bold, italic, underline, shadow, and strikethrough.

Chart: A graphic that transforms numerical data into a more visual 
representation.

Clear All Formatting: Command that removes any formatting 
at has been applied to text, including character formatting, text 

effects, and styles and leaves only plain text.

Clip art: Copyright-free strations, photographs, audio clips, 
and video clips that are made ava hrough PowerPoint to use 
in presentations.

Close co Command that removes a presentation from 
your computer screen but leaves the PowerPoint application open.

Color theme: A set of colors that complement each other and are 
designed to work well in a presentation. A color theme will change 
the color of backgrounds, placeholders, text, tables, charts, Smart-

t, and drawing objects in a presentation.

Col : A vertical arrangement of text on-screen. Text at the bot-
tom of one column continues on to the top of the next column.

Comment: A small text note that is added to a slide that is not 
meant to be a part of the presentation.

Compa b ity Checker: Tool that checks for con icts between 
the current presentation and previous versions of PowerPoint.

Content placeholder: A special type of placeholder that provides 
a quick way to add a variety of materi  to presentations, including 
tables, charts, SmartArt diagrams, pictures, clip art, and videos.

Conte bs: on tabs that contain commands spe
ype of object selected and are only visible when the commands 

might be useful.

Contrast: Feature that changes t ge of color intensit in 
a picture.

Copy: Command that places a duplicate of the selected text or 
object on the Office Clipboard without changing t

Crop: Remove part of an image, hiding it from sight.

Custom slide show: A slide show that runs inside another slide 
show. Custom slide shows can be accessed through the Custom 

Show menu in Slide Show view or through a hyperlink.

Cut: Comm hat removes the selected text or object from the 
ipboard for later use.

e
Embedded object: Independent object that is pasted into a presen-
tation. Double-clicking an embedded object will open the object 
inside the PowerPoint presentation, using the source program but 
not the sourc

E ed ScreenTip: A ScreenTip that displays not only the n
of the command but a eyboard shortcut (if ther
a short description of what the button do n it is used.

t com Command that removes a presentation from your 
computer screen and closes the PowerPoint application.

f
F b: on tab located at the f t side that opens Micro-
sof stage view.

Find: Command that locates specific instances of text in a 
presentation.

Font: A set of characters of a certain design. The font is the shape of 
the character or n er as it appears on-screen. 

Footer: Text that appears on every slide or handout. Typica , a 
footer appears at the bottom of a slide or handout.

Format Pa ter: Tool that copies and pastes formatting styles from 
one object to another.
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g
Gridlines: A series of dotted vert  and horizontal lines that 
divide the slide into sm l boxes. Used as visual marke igning 
placeholders and graphics.

Group: Subsection of a t on; org izes similar com-
mands together.

h
Handout: A printout of a presentation with an here from one to 
nine slides per pag h areas for taking notes.

Handout Maste w: Master view where the printed version of a 
presentation is mod d.

Handout masters : Master that controls how the slides in a presen-
tation look when printed.

Header: Text which appears on every slide or handout. T ly, a 
header appears at the top of a handout.  

Hi ighter tool: Slide show tool that adds color behind text on 
slides in Slide Show view and emphasizes parts of a slide.

Home tab: on tab that contains the most commonly used 
commands for PowerPoint.

Horizont ignment: Position of text  regard to the left and 
right edges of a cell or placeholder.

H erli Text or a graphic that can be clicked to open another 
file or jump her place in the presentation. 

k
Keyboard shortcuts: Keys or combinations of keys that when 
pressed execute a command.

l
Layout: Template for arranging elements on a slide.

Line spacing: The white space between lines of text.

Li ed object: Dependent object that is pasted into a presenta-
tion. Double-clicking a linked object will open the sourc n the 
original application for editing.

Live Preview: The display of formatting ch ges in efore 
actua mitting to the change.

m
Master views: Contain unive ings for the presentation, and 
i ide Master view andout Master view
Notes Master view. 

Metadata: Information describing ncluding ke ord tags, 
the file title, and the author.

Microsof e Back w: File tab that contain -
mands for managing and protecting ncluding Save, Open, 

Close, New, and Print. Backstage replaces the O ton menu 

fr he File menu from previous versions of 
Office. 

M  toolbar: Tool at provides access to common commands 
for wor ng  text and graphics. When you select text and leave 
the mouse over the text, the Mini toolbar fades in.

Mo A multimedia clip which includes moving images and 
sounds.

n
New command: Command that creates a ne n an Office 
application without exiting and reopening the program.

Norm w: The view where content is created and edited. Nor-
m iew consists of the Slide and Outline tabs, Slide

Notes

Notes Master view: View that controls how the printed notes 
pages will look. 

Notes masters: Maste at controls the look of notes when 
printed along with the slides.

Notes Page view: The view where notes are displayed along with 
slides in a presentation. 

Notes pages: The printed copy of the slide with its associated note.

N bered list: List t e used to organize information that must 
be presented in a certain order.

o
ce Clipboard: Task pane that displays up to 24 copied or 

cut items for use in the current presentation or any othe
application.

Outl e tab: Feature that displays only the text from the slides in a 
presentation in an outline format. U Outline tab to ente
edit text directly in the outline.

p
Package for CD: lows you to copy your presentation to a 
CD dire om inside PowerPoint. The PowerPoint viewer is 
included by default, allowing you to run your presentation from any 
computer.

Paste: Command that inserts text or an object from the Office 
Clipboard in

Paste Special: Comm hat inserts objects from other Office 
applications into PowerPoint. Objects can be pasted as linked or 
embedded objects.

PDF (portable do nt Adobe’s cust mat that 
preserves the formatting of the do nt and is ea eadable, but 
not easily editable.

Pen tool: Slide show tool used rline or circle important 
points in Slide Show view a y are discussed.

Phot : Feature that a ws you to create a presentation of 
digit mages with captions.
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Placeholders: A container on a slide that holds text or other con-
tent, such as a table, chart, or image.

PPI: Acronym for pixels per inch; used to measure picture resolu-
tion when compressing images in presentations.

Presentation: A multimedia slide show that combines text, 
images, charts, audio, video, animations, and t sitions to convey 
information.

Presentation properties: Information about a presentation, such 
as the location of the presentation, the size of t n the pre-
sentation was created and when it was last modified, the ti
the author.

Protected View: Read-only format that protects your computer 
from becoming infected by a virus or other m are.

q
Q k Access Toolbar: Toolbar located at the top of the applica-
tion window above the File tab. The Quick Access Toolbar gives 
quick one-click access to common commands.

Q k Layout: Combinations of labels, titles, and data tables 
applied to charts.

Q k Style: Formatting element that gives a presentation a more 
polished, graphical look without a lot of work. Quick Styles include 
fills, borders, shadows, r ctions, and picture shapes.

r
Reading view: The view that r s the presentat in the 
PowerPoint application window.

Recolor command: Command that removes all colors from a pic-
ture and replaces them with shades of one color.

Redo: Command that reverses the Undo command and restores 
the file to its previous state.

Rehearse timings: Feature that runs esentation while record-
ing the time spent on each slide. 

Replace: Command that is used with the Find command to insert 
spe d text in h new text.

Reset Picture: emove all PowerPoint formatting 
applied to a picture, revertin re to its state before any for-
matting was applied.

Reuse Slides task pane: Ta hat allows you to add slides 
from other presentations or from a Slide Library.

bbon: Graphic interface across the top of the application win-
dow that organizes common features and commands into tabs.

s
Screenshot: An image of what is currently displaye -
puter screen (such as an open application window or of a Web page).

ScreenTip (hyperli A bubble with text that appears when the 
mouse hovers over a hyperlink. Typica , a ScreenTip provides a 
description of the hyperlink.

ScreenTip ( bbon): A small information box that displays the 
name of t and when the mouse hovers over a button on 
t on.

Sections: Smaller groups of slides within a presentation to help bet-
ter organize the content.

Shape: A drawing object that can be qu d to a presentation.

Sharpness: Feature that removes any blurriness from a picture, giv-
ing it a crisper feel.

Shortcut menu: List of commands that appe te ea of the 
application window is right-clicked.

Slide: A unit within a presentation. Each slide contains content, 
including text, graphics, audio, and video.

Slide library: Slides that have been uploaded to a server for others 
to view and use in r presentations. 

Slide master: A slide template that is used throughout a presenta-
tion to create a consistent look and feel.

Slide Sh w: The view that displays the slides fu -screen and 
displays the presentation as udien l see it.

Slide Sorter view: The view that displays a grid of thumbna
tures of the slides in a presentat seful in rearranging the 
order of slides in a presentation.

Slides tab: T at displa umbna ides in a pre-
sentation. Use the Slides tab to qu avigate between slides and 
rearrange the slide order of presentation.

SmartArt: Visual diagram containing graphic elements with text 
boxes for entering information.

Softness: Feature that removes hard edges from a picture, giving it 
a smoother feel.

So : Music or sound effects that can be added to slides.

Sp er notes: Hidden notes you add to slides throug Notes 
pane.

Spelling checker: Analyzes your entire presentation for spelling 
errors, and presents any errors in a dialog box, enabling you to make 
decisions about how to handle each error or type of error in turn.

t
Tab: Subsection of t on that organizes commands into 
related groups.

Table: Content element that helps organize information by rows, 
which display horizonta mns, which display vert ly.

Tags: Ke ords describing t

Template: h predefined settings that can be used as a pat-
tern to create a ne

Text boxes: Boxes that are added to the slide layout to enter text 
an here on the slide.

Text placeholders: Predefined areas in slide layouts where text is 
entered.

Theme: A group of formatting options that is applied to an entire 
presentation. Themes include font, color ct styles that 
are applied to specific elements of a presentation owerPoint, 
the nclude background styles.

Theme e ects: Aspect of the theme that controls how graphic ele-
ments appear.

Transition: A ct that occurs when one slide leaves the screen 
and another one appears.
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u
Undo: Comm at reverses the last action performed.

v
Vertical alig ent: Position of text with regard to the top and bot-
tom of a cell or placeholder.

w
WordArt: Pre ned graphic styles that are applied to text. These 
styles include a combination of colors, fills, outlines, and effects.

x
XPS (XML paper speci ation): Microsoft’s file format that 
preserves the formatting of the document and is easily readable 
but not easily editable. XPS files can be opened with Microsoft’s 
XPS Viewer, which comes insta d with Windows Vista and 
Windows 7.

z
Zoom slider: Slider bar that controls how large or sma ides are 
displayed in Slide pane. It is located at the right side of the status 
bar at the bottom of the application window.
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a
Action button, PP-36, PP-124
Action Settings dialog box, PP-124
Add

clip art, PP-38
comments, PP-93
hyperlink, PP-92
movies, PP-42
picture, PP-40
screenshot, PP-39
sections, PP-9
shape, PP-36
slides, PP-8, PP-138
SmartArt, PP-35

, PP-41
text, PP-25, PP-37
Word t, PP-30 to PP-31

A imation button, PP-74
Add Section, PP-9
Adding columns to text placeholders, PP-141
Adding slides from another presentation, PP-138
Advanced Animation g lery, PP-73

ign button, PP-71
igning, PP-71, PP-72
igning text, PP-117 to PP-118, PP-140

Animating charts, PP-121
Animation, PP-73, PP-74, PP-121 to PP-123, PP-145
Animation Painter, PP-145
Animation Pane button, PP-74
Animation task pane, PP-121
Animation timings, PP-123
Applying columns to text, PP-141
Artistic Effects, PP-110
Aspect ratio, PP-69, PP-114
Audio, PP-126 to PP-127
Audio Tools contextual tab, PP-41
Audio Tools Playback tab, PP-126
Author property, PP-

b
Background, PP-60
Background Removal tab, PP-111
Background Styles button, PP-60
Background Styles gallery, PP-60
Backstage, PP-vi
Balance, PP-
Basic custom slide show, PP-90
Basic shapes, PP-36
Block arrow, PP-36
.bmp, PP-153

Bold, PP-139
Bottom alignment, PP-140
Brightness, PP-112
Broadcast Slide Show d g box, PP-160, PP-161
Broadcasting a presentation, PP-160 to PP-161
Bullet style, PP-147, PP-148
Bulleted list, PP-26 to PP-27
Bullets and Numbering dialog box, PP-27
Bullets button, PP-27, PP-147

c
Ca t, PP-36
CD/US sh drive, package for, PP-158 to PP-159

, PP-33
Cente ignment, PP-140
Changing the order of slides, PP-87
Character cts, PP-139
Character spacing, PP-139
Chart, PP-34, PP-120, PP-121
Chart Layouts, PP-120
Chart Styles, PP-120
Chart Tools Design tab, PP-120
Chart Tools Format tab, PP-120
Chart Tools Layout tab, PP-120
Check Compatibility, PP-151, PP-152
Choose a SmartArt Graphic dialog box, PP-35
C l Formatting, PP
Clear Table button, PP-64
Clip art, PP-38
Clipboard, PP- iii, P-89
Clipboard dialog launcher, PP-89
Close, PP-x
Color button, PP-113
Color theme, PP-58
Columns dialog box, PP-141
Comments, PP-93
Compat ity Checker, PP-151, PP-152
Compress Pictures, PP-115
Content placeholder, PP-32
Content-spe rs, PP-149
Cont al tabs, PP-vi
Contrast, PP-112
Convert to SmartArt Graphic button, PP-35
Copy, PP- iii, PP-88
Corrections button, PP-112
Corrections gallery, PP-112
Create Video button, PP-164
Cropping h le, PP-114
Custom slide show, PP-90, PP-97
Cust me, PP-57
Customizing PowerPoint, PP-xi
Cut, PP- iii

 index 
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d
Date and time, PP-13
Decrease indent button, PP-27
Default chart type, PP-34
Define Custom Show dialog box, PP-90
Delete Comment button, PP-93
Delete Slide, PP-86
Design principles, PP-
Distinction, PP-xii
D ’ts, PP-xii
Drawing Tools Format contextu ab, PP-31
Duplicate, PP-88

e
E-mail, PP-155, PP-159
Edit Shape button, PP-65
Editing text, PP-6
Effect Options button, PP-11
Embedded objects, PP-
Emphasis animations, PP-73
Enable Editing, PP-xiv
En ced ScreenTip, PP
Ent imations, PP-73
Equation shape, PP-36
Exit an ations, PP-73
Exiting PowerPoint, PP- i

f
File size, PP-115
Find, PP-
Flow, PP-xii
Flowchart, PP-36
Font, PP-61
Font Color button, PP-61
Font dialog box, PP-139
Font Size box, PP-61
Footer, PP-13
Format Painter, PP-143
Format Picture dialog box, PP-112
Format Shape d g box, PP-65
Formatting

aligning, PP-71, PP-72
animations, PP-73, PP-74
background, PP-60
clearing, PP
color theme, PP-58
font, PP-61
gr ines, PP-68
grouping, PP-71, PP-72
Quick Styles. See Quick Styles
rotating, PP-71
ruler, PP-68
sizing, PP-69, PP-70
SmartArt, PP-66
text box, PP-62, PP-63

me, PP-57
cts, PP-59

Frame Slides, PP-100

g
.gif, PP-153
Graph cts, PP-59
Graphic file formats, PP-153
Gr uides d g box, PP-68
Gridlines, PP-68, PP-72
Group, PP-vi
Group button, PP-71
Grouping, PP-71, PP-72

h
Handout, PP-100
Handout master, PP-12
Handout Master button, PP-99
Handout Master view, PP-5, PP-99
Handouts layout, PP-100
Header, PP-13
Header & Footer button, PP-13
Heading 1 style, PP-28
Heading 2 style, PP-28
Help, PP-
Help toolbar, PP-
Hide Slide button, PP-91
Highlighter, PP-96
Home tab, PP-vi
Hyperlink, PP-92
Hyperlinked custom slide show, PP-90

i
Increase indent button, PP-27
Insert. See Add
Insert Audio d g box, PP-41
Insert Chart dialog box, PP-34
Insert H erlink dialog box, PP-92
Insert Layout button, PP-149
Insert Movie dialog box, PP-42
Insert Picture d g box, PP-40
Insert Placeholder button, PP-25, PP-70, PP-149, PP-150
Insert SmartArt Graphic button, PP-35
Insert Video button, PP-42
Italic, PP-139

j
.jpg, PP-153
Justified alig nt, PP-140

k
Keyboard shortcuts, PP-vi to PP-vii

l
Last Viewed, PP-97
Layout, PP-146 to PP-150
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Layout button, PP-29
Lef ignment, PP-140
Line, PP-36
Line spacing, PP-142
Linked objects, PP-
List

bulleted, PP-26 to PP-27
columns, PP-141
multilevel, PP-27
n ered, PP-26 to PP-27

Live Preview, PP-x

m
Master view, PP-5
Microsoft Access, PP-iv
Microsoft Excel, PP-iii, PP-34
Microsof P-iii to PP-v
Microsof stage view, PP-vi
Microsoft PowerPoint, PP-iv
Microsoft PowerPoint Help, PP-
Microsoft Word, PP-iii
M lignment, PP-140
Mini toolbar, PP-ix
Motion Path animations, PP-73
Movie, PP-42
Moving a graphic, PP-36
Multilevel list, PP-27
Multipar ations, PP-122

n
New, PP
Ne ent button, PP-93
New presentation

k presentation, PP-
template, PP-

New Slide button, PP-8
New Slide button arrow, PP-138
Normal view, PP-4
Notes and Handouts tab, PP-13
Notes master, PP-12
Notes Master view, PP-5, PP-12, PP-15
Notes Page button, PP-14, PP-15
Notes Page option, PP-100
Notes Page view, PP-5
Notes pane, PP-3
Notes view, PP-14
N ered list, PP-26 to PP-27
N ering button, PP-27

o
lipboard, PP- iii, PP-89

P-38
ome and Business, PP-v
ome and Student, PP-v

rofessional, PP-v

Open, PP-xiii
Outline tab, PP-7

p
Package for CD, PP-158
Page Options button, PP-100
Paragraph dialog box, PP-142
Paste, PP- iii, PP-88
Paste Special, PP-xix
PD P-155
Pen, PP-96
P P-40, PP-129
Photograph slide shows, PP-40
Picture, PP-40, PP-67

tist cts, PP-110
compress, PP-115
corrections, PP-112
crop, PP-114
recolor, PP-113
remove backgr , PP-111
reset, PP-116
transparency, PP-113

Picture Quick Styles, PP-67
Picture Styles gallery, PP-67
P e Tools contextual tab, PP-39
Placeholder, PP-146, PP-149, PP-150

content, PP-32
edit, PP-6
move, PP-6
resize, PP-6, PP-70
text, PP-25
type, PP-3, PP-25, PP-149

.png, PP-153
Pointer Options button, PP-96
PowerPoint Options d g box, PP-xi, PP-115
PPI, PP-115
Presentation, PP-3

broadcast, PP-160, PP-161
close, PP-x
design, PP-xii
open, PP-xiii
package for CD/US sh drive, PP-158 to PP-159
properties, PP- ii
save, PP- P-155, PP-156 to PP-157

Presentation Properties, PP- ii
Presentation tools, PP-96
Presenter view, PP-15
Print

nts/i arkup, PP-100
handout, PP-100
Handout Master view, PP-99
notes, PP-100
options, PP-98
ou ine, PP-100
previewing slides, PP-98, PP-99
slides (presentation), PP-98
speaker notes, PP-15

Print tab (Backstage view), PP-98, PP-100
Protected View, PP-
Publish Slides dialog box, PP-162, PP-163
Publishing slides to Slide Library, PP-162 to PP-163
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q
Quick Access toolbar, PP-viii
Quick Layouts, PP-120
Quick Styles, PP-120

picture, PP-67
shape, PP-65
table, PP-64
text box, PP-63
Word t, PP-31

r
Reading view, PP-4, PP-5
Record Slide Show, PP-125
Rectangle, PP-36
Recurrence, PP-xii
Redo, PP-
Rehearse Timings, PP-94, PP-96
Remove Background button, PP-111
Remove H erlink button, PP-92
Remove Section, PP-9
Rename Section, PP-9
Replace, PP-xxi
Reset button, PP-10
Reset Picture, PP-116
Resize. See Sizing
Resize handle, PP-36, PP-62, PP-69

on, PP-vi
ht alignment, PP-140
ht-click shortcut menu, PP-vii

Rotate button, PP-71
Rotate handle, PP-36
Ruler, PP-68

s
Sans serif fonts, PP-61
Save & Send tab, PP-158, PP-162, PP-164
Save as

graphic, PP-153 to PP-154
PDF, PP-155
template, PP-156 to PP-157
video, PP-164

Save As dialog box, PP- P-153, PP-156
Sc it Paper, PP-100
Screen Clipping tool, PP-39
Screenshot, PP-39
Screenshot g ry, PP-39
ScreenTip, PP-ix, PP-92
Section, PP-9
Security warnings, PP-
Serif fonts, PP-61
Shadow, PP-139
Shape, PP-36, PP-37, PP-65
Shap cts button, PP-62
Shape Fill button, PP-62
Shape Outline button, PP-62
Shape Styles gallery, PP-62, PP-63, PP-65

Shapes button, PP-36
Shapes g lery, PP-36
Sharpness, PP-112
Show M kup button, PP-93
Shortcut menus, PP-vii
Sizing

age, PP-69
placeholder, PP-70

Slide, PP-3
change the slide order, PP-87
copy, PP-88
delete, PP-86
hide/unhide, PP-91
number, PP-13, PP-87
paste, PP-88

Slide background, PP-60
Slide layout, PP-8, PP-10
Slide Library, PP-10, PP-162 to PP-163
Slide master, PP-12, PP-146 to PP-150
Slide Master tab, PP-12
Slide Master view, PP-5
Slide number, PP-13, PP-87
Slide pane, PP-3
Slide show

custom, PP-90, PP-97
exit, PP-96
last viewed slide, PP-97
navigation, PP-96, PP-97
next/previous slide, PP-96
notations, PP-96
record, PP-125
start, PP-95

Slide show navigation, PP-96
Slide Show toolbar, PP-97
Slide Show view, PP-4, PP-5
Slide Sorter view, PP-4, PP-87
Slide transitions, PP-11
Slides tab, PP-6, PP-7
SmartArt, PP-35, PP-66
SmartArt Tools contextu ab, PP-66
Softness, PP-112
So d, PP-41
S P-41
S P-41
Spacing

character, PP-139
line, PP-142

Speaker notes, PP-14 to PP-15
Sp ing checker, PP-
Stars and banners, PP-36
Startin ide show, PP-95
Strikethrough, PP-139

t
Tab, PP-vi
Table, PP-33, PP-64

aligning text, PP-117 to PP-118
insert/delete rows/columns, PP-119

Table Quick Styles gallery, PP-64
Template, PP-xii, PP- i, PP-156
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10/20/30 rule, PP-xii
Text, PP-25
Text alig nt, PP-117 to PP-118, PP-140
Text box, PP-25, PP-62, PP-63
Text direction, PP-119
Text placeholder, PP-25
Theme, PP-57, PP-58
Theme Color button, PP-58
Theme Colors g lery, PP-58
Theme effects, PP-59
Themes button, PP-57, PP-146
Themes gallery, PP-57
.t , PP-57
Th bnail, PP-6
.tif, PP-153
Timing, PP-94
Top alignment, PP-140
Transform gallery, PP-31
Transitions, PP-11
Transparent Color, PP-113
Trim Audio d g box, PP-126
Trim Video d g box, PP-128
Trust Center, PP-xiv
Trusted Locations, PP-xiv

u
Underline, PP-139
Undo, PP-xx

US sh drive, package for, PP-158 to PP-159
User interface, PP-vi

v
Vertica ignment, PP-140
Video, PP-128
Video Tools Playback tab, PP-128
View, PP-4 to PP-5

w
.wmv, PP-164
Word document, PP-28 to PP-29
WordArt, PP-30 to PP-31
WordArt Quick Styles, PP-30

x
XPS file, PP-155

z
Zoom bar, PP-5
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